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Take a look at any book or magazine and you will find that we are surrounded by
incredible macro photos. Whether you choose a cookery book, a gardening periodical
or a lifestyle magazine, you will be faced with apparently perfect flower blooms,
cupcakes, table decorations and even perfect-looking insects captured from extreme
and often unusual perspectives. With all this perfection around, why bother shooting
your own macro photos?

The answer is simple – because all that perfection lacks emotion. It is all too easy for us
photographers to be put off by the all-encompassing world of perfect imagery and to
feel insecure about the quality of our own work. But the daily flood of images can
provide inspiration too, and often provides the kick-start we need to go out and create
our own wonderful pictures with their own personal message. Nothing tops the thrill
of experimentation and it is the courage to invent that often produces the most
interesting results. 

To get you going, check out George Lepp’s focus stacking workshop on page 44,
Torsten Hoffmann’s tips on how to see the world with fresh eyes on page 116 or
Michael Jordan’s take on available light photography on page 76. And, if you thought
high-end close-up gear is too expensive, our macro lens test on page 60 shows that
you don’t have to spend a fortune to get up close and personal with all those great
subjects out there.  

It’s time to head out into the garden!

Sophia Sieber 
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Portfolio 
Models attired in hand-made historical costumes and
captured to look like Renaissance figures are the keys
to Christian Tagliavini's fascinating portraits.

12        Christian Tagliavini: Portfolio

Full-frame on the Rise
Sony's new mirroless models have shaken up the world of 
full-frame photography. We look at the ins and outs of 
switching to a larger sensor and test the A7s alongside their 
more traditional rivals.

18        Switching to Full-frame
22        Sony A7(R) vs. Leica M and Nikon D800(E)
34        Using the Sony A7 with Lens Adapters

Telephoto Super-Zoom Test
The Canon EF 200-400 mm f/4L Extender offers maximum
performance in a high-quality, high-price package. We take 
this spectacular mega-lens for a spin.

38        Canon EF 200-400 mm f/4L Extender Test

Macro Photography Special
Our focus stacking workshop with renowned photographer
George Lepp and our in-depth lens test will help you get
up close and personal with small-sized subjects.

44        Focus Stacking Workshop
60        8 Prime Lenses Tested

Natural Light
Sunlight is the most widely used photographic 
light source. This article looks at how to develop 
a feel for natural light and how to use it to 
capture unique images.

76        Introduction
79        What is light?
84        Capturing Architectural Subjects
86        People and Portraits
90        Landscapes

GIMP Lighting Workshop
This workshop shows you how to use GIMP 
to produce wonderful, etheral volumetric lighting 
effects and apply them to your own images.

92        Introduction
96        Step-by-Step Guide

LightZone is Back
Back from the dead, LightZone is now available 
as part of an ongoing open source project. We 
take a detailed look at its new incarnation.

100      Introducing the New LightZone

The Sony A7 Hits Town    22 Focus Stacking    44
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Free DVD
8          Highlights
9          Contents

Full version software: Photomizer Scan 2.0.13.704 
A comprehensive and easy-to-use package for processing
and tweaking digitally scanned photos and negatives.

Full version software: ACDSee Pro 5.3.168
A pro-grade processing and management suite for all
photographers who shoot in RAW formats. 

Videos
• David Burnett – Feelings and Memories
• Focus Stacking with Helicon Focus
• Josh Westrich – A Passion for Flowers
• Safe Portraits – Great Photos in No Time

Lightroom vs. Photoshop
Lightroom has evolved into a powerful all-in-one digital
photo workflow tool. We look at its latest tools and show
you where Photoshop still has the upper hand.

106      Moving an Object
108      Distortion Correction
110      Gradients and Masks
114      Content-Aware Scaling

Learning to See
Great photographers express emotions and sensations visually
using timing, solid composition and the right attitude. This
workshop explains how to develop these skills for yourself.

116      Introduction
122      Rules of Composition
126      Ways to Portray the World
130      Direct Perception
134      Meditative Photography

About Us
3      Editorial
6      Reader forum

136      Book Review
138      Coming Up in Issue 17
138      Contact Info

Natural Light    76
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DVD Download

If your copy of the magazine contains no DVD, navigate to
www.ct-digiphoto.com/dvd162014  to download the DVD
content for free. 

Macro Lens Test    60



Canon/Nikon Duopoly
Regarding your issue
#15: why do you find it
necessary to limit your
equipment comparisons
to the Canon/Nikon
duopoly? Instead of
comparing just the
Canon 70D and Nikon
D7100, why not also
include similarly priced
competitors from
Pentax and Sony? Is it
not more journalistically
ethical to compare
available products from
all the producers of

similarly priced products, rather than 
helping Canon and Nikon retain their current
market power? For that matter, why not 
also include comparably priced mirrorless
cameras? Oh yes, Canon and Nikon don’t 
have such cameras, whereas Fuji, Olympus,
Panasonic, Samsung and Sony do. Shame on
you. I likely will let my subscription expire if
such Canon/Nikon bias continues. 

Mark Van Bergh

Thanks for your remarks and your question.
Of course, we have to limit the number of devices
we test – in this case to the comparison of Nikon
and Canon cameras. Our aim is not to perform
‘diplomatic’ tests that please everybody by
including all possible cameras from every

manufacturer. Why? Because the outcome of
such a test would be  confusing and not to the
point. That’s why we limit each of our camera
comparison tests to only a few manufacturers. If
you browse through past issues,  you will
discover tests that include Pentax, Sony,
Panasonic and other brands too. We select our
test gear independently, which the camera
manufacturers don’t always like but still 
have to live with. The major risk of this approach
is that we then receive mails from readers 
who miss the cameras we haven’t included!
Please stick with us – there are plenty of great
non-Canon/Nikon tests coming up. 

Latitude and longitude

In Issue 15 of c’t Digital Photography, page 90,
in GPS Data Formats and Exif Tags (first
column), the article states: “Latitude is
measured using values between 0 and 180
degrees east or west of the Greenwich
Meridian in London, and longitude is
measured using values between zero and 90

degrees north and south from the equator.”
The Latitude and Longitude is wrongly stated.
It should be the other way round. Longitude is
measured using values between 0 and 180
degrees east or west of the Greenwich
Meridian in London, and Latitude is measured
using values between zero and 90 degrees
north and south from the equator.

Thank you very much for your input. The
swapped words you spotted are the result of a
basic translation error that unfortunately slipped
through the copy editing net. It is thanks to
comments like yours that we are able to spot
where we need to tighten our pocesses to further
improve the quality of the magazine. Thanks
again for your help and keep reading!

You are welcome. I always think your
magazine is a great one. 

Lawrence Sze-Ying Lau 
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Reader Community

Reader Forum

We are always happy to receive your
comments and suggestions in a letter,
an e-mail (editor@ct-digiphoto.com) or
at www.facebook.com/ct-digiphoto.
We reserve the right to abbreviate 
your input for publication. Our 
comments are printed in italics.

Tell us what
you think:
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Photomizer Scan 2 

Full version sofware: Photomizer Scan is a highly automated
application that helps to bring out the full potential of scanned
negatives and prints.

Detail and color are often lacking in scans of
analog photos. The Photomizer Scan full version
software we have included here provides the
functionality you need to optimize scans of
negatives and photos, automatically adjusting
exposure, contrast and saturation to produce
great results. 

The program has automatic object
recognition to keep the number of edited
pixels to a minimum and also includes tools for
reducing image noise and removing other
unwanted artifacts. All the settings are easy 
to apply, making the software perfect for
beginners and experienced users alike. The
split-screen interface, with its zoom and
full-screen preview tools, gives you an instant
overview of the original scan and the current
state of your adjustments. 

Use of the full functionality requires online
registration during installation. Once
registered, c’t Digital Photography readers will
receive a serial number via e-mail and a special
offer that gives you US$50 off an upgrade 
to the current pro version or US$130 off 
the Photoshop plug-in version, valid until 
October 31, 2014. The registered full version is
valid for an unlimited period. (tho)

ACDSee Pro 5.3.168

Full version software: A pro-grade
processing and management suite for
all photographers who shoot in RAW
formats.

This versatile photo editing and management
package is a great all-in-one photo workflow
tool aimed at pro and advanced amateur
photographers. It includes RAW conversion 
and non-destructive editing functionality and
provides a wide range of advanced image
adjustment tools. 

The built-in development tools include
red-eye removal, dodge and burn, and shadow
and highlight adjustment as well as noise
reduction, perspective correction, vignetting,
anti-distortion, batch processing and patented
Lighting and Contrast Enhancement (LCE),
functionality. Hue, saturation and brightness
can be finely tuned in the Advanced Color
module and Smart Sharpening gives your
images a final polish. 

Alongside its editing functions, the program
also offers a powerful image search and
management module that works directly with
your computer’s directory tree and includes
auto-categorization based on Exif data as well
as manual tagging and rating tools. Support for
online services makes it simple to share your
work with others.

To activate the software, register at
en.software-choice.com/acdseepro5. You will
then receive a serial number and further
information on the activation process via e-mail.
Please note, new serial numbers have to be
requested by September 5th in Europe, by
September 26th in the US and Canada and by
November 7th in Australia and the rest of the
world. Additionally, all users who have an
ACDSee account can upgrade to the current pro
version for just US$59.99. (sea)

‘Safe’ Portrait Workshop

Video tutorial: Pro photographer Bert Stephani explains how to produce ‘safe’
portraits in a minimum of time.

Bert Stephani is a pro portrait photographer
who knows just how to get a shoot running
smoothly. In order to ensure relaxed interaction
between the photographer and the model, it 
is essential to produce tangible results that 
the subject can view right from the start of 
a session. 

This video introduces the techniques he uses
to produce quick portraits that set the scene for
a productive shoot. For example, for indoor
shoots, he recommends positioning female
subjects in daylight near a window and shooting
using a relatively warm white balance setting.
Use of reflectors, changing your viewpoint and
switching between portrait- and landscape-
format shots are all ways to keep the look of the
resulting images varied and interesting. 

The main part of this video shows Stephani
putting his tips and tricks into action with model
Svetlana, and he rounds up by giving us some

ideas on how to produce excellent portraits of
male subjects too. 

These techniques are all quick and easy to
apply and make it possible to produce excellent
sample portraits in the space of just five
minutes. (sea)
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Contents | Free DVD

Image Processing Tools

Windows

ACDSee Pro 5.3.168

Artweaver Free 4.5.3

GIMP 2.8.10

GIMP Portable 2.8.10

GREYCs Magic Image Converter (GMIC) 1.5.8.6

HeliosPaint 1.6

Hugin 2013.0.0

Liquid Rescale 0.7.1

Liquid Rescale Portable 0.7.1

Photomizer Scan 2.0.13.704

PSPI 1.0.7

StylePix 1.14.3.2

StylePix Portable 1.14.3.2

Mac OS

GIMP 2.8.10 for Mavericks

GREYCs Magic Image Converter (GMIC) 1.5.8.6
for Mavericks

HeliosPaint 1.6

Linux

GREYCs Magic Image Converter (GMIC) 1.5.8.6

HeliosPaint 1.6

PSPI 1.0.5 for Ubuntu

PSPI 1.0.7 for SUSE 10

Photo Tools

Windows

AmoK Exif Sorter 2.56

ExifTool 9.59

Helicon Photo Safe 4.10

IrfanView 4.37

IrfanView PlugIns 4.37

IrfanView Portable 4.37

PhotoRec 6.14

Piwigo 2.6.2

The Rasterbator 1.21

WordPress 3.9.1

XAMPP 1.8.3

XAMPP Portable Light 1.8.3

Mac OS

AmoK Exif Sorter 2.56

ExifTool 9.59

MacPorts 2.2.1 for Mavericks

PhotoRec 6.14

Piwigo 2.6.2

WordPress 3.9.1

XAMPP 1.8.3

Linux

AmoK Exif Sorter 2.56 32-bit

AmoK Exif Sorter 2.56 64-bit

ExifTool 9.59

Gallery 3.0.9

PhotoRec 6.14 32-bit

PhotoRec 6.14 64-bit

Piwigo 2.6.2

WordPress 3.9.1

XAMPP 1.8.3 32-bit

XAMPP 1.8.3 64-bit

Sample Images
Camera Test Sample Images

Lens Test Sample Images

Videos
David Burnett – Feelings and Memories, Part 1

Focus Stacking with Helicon Focus

Josh Westrich – A Passion for Flowers

Safe Portraits – Great Photos in No Time







Spontaneous photos are not Christian
Tagliavini’s thing at all. Weeks, even

months, build up to the moment when he and
his team have finished their preparations and
he can at last release the shutter. 

After training as an architect and graphic
designer, Tagliavini began taking
photographs quite late in his career. Not only
is he a self-taught photogppaher, he still
performs almost every part of the creative
process himself, from designing the costumes
to casting the models and applying their
make-up.

“What fascinates me most is that I am not
just responsible for the final ‘click’,” says the
42-year-old. “I don’t really see myself as a
photographer. I’m more like a photographic
craftsman. I also really like playing the

designer and dreaming up clothing that
nobody would actually wear.”

Such clothing was a feature of his two 
latest sequences, Carte and 1503, which
brought him to the attention of the
international photography scene. His
large-format photographs are now exhibited
and sold around the world at such illustrious
addresses as the Paris Photo show and the
CWC Gallery in Berlin (camerawork.de). They’re
also winning him awards – the Hasselblad
Masters Award in the Fine Art category in 2012
for his 1503 series (see page 14) and the
International Photography Award in 2013 for
the Carte series shown opposite. 

All Tagliavini’s images, from his earliest
works to his 2013 award-winners, illustrate his
never-ending quest for perfection. Tagliavini

has always been dedicated to detail and his
images are painstakingly put together. “Even
after I’ve captured a photo, I’m never happy
with the result and I always want to do it
again,” he says. “I always try to pay maximum
attention to every tiny detail.”

The technology he uses also has to meet
his exacting standards and be fit for the
purpose. Large or medium format gear is a
must, and these days that also means working
exclusively with digital equipment. The
images for 1503 were shot using an analog
Sinar large-format camera, although he has
since switched to medium-format digital gear.
It was a difficult decision, he says, but
unavoidable because achieving the quality he
wanted using analog equipment used up a
disproportionate amount of time and effort.
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Portfolio | Christian Tagliavini

Portfolio

Christian Tagliavini
Models attired in paper and cardboard and portraits that look like
centuries-old paintings – Swiss photographer Christian Tagliavini
stage-manages stories that sometimes seem real, sometimes surreal,
playfully mixing two- and three-dimensionality and using stylistic
elements from a bewildering range of historical periods.



13c’t Digital Photography 16 (2014)

Four playing cards from the Carte series, completed in 2012. Each of the cards – from Jack to
Queen and Ace – has its own unique character but is also linked to the others by hidden symbols
and hints. What also appealed to Tagliavini about this project was the opportunity to play with
two- and three-dimensionality by dressing real people in laser-cut paper and cardboard costumes
he designed himself.
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With titles like Cecilia, Lucrezia and
Bartolomeo, these images appear to be from
another era. They look like merchants,
members of the nobility and high-ranking
citizens, and in some ways they are, for these
portrait subjects are modeled on the art of
Florentine painter Agnolo di Cosimo, also
known as ‘Il Bronzino’. The title of the series is
the year of the painter’s birth. 

It took Tagliavini 13 months to put this
sequence together. Like Il Bronzino, he likes to

emphasize details that are unique to the
subject, such as the scribe’s quill pen in the
image above. Unlike in Il Bronzino’s work,
however, all these people appear to have
extremely long necks. Tagliavini is adamant
that this effect has nothing to do with
Photoshop and that it is the product of an
illusion borrowed from his other trade as 
an amateur magician. Like all true magicians,
he didn’t want to reveal how this particular
trick works. (keh)

Ritratto d’uomo from Christian Tagliavini’s 1503 series shows 
a scribe portrayed the same way Renaissance artist Agnolo di Cosimo 
(aka ‘Il Bronzino’) might have painted him

Links

CWC Gallery: www.camerawork.de 

Paris Photo: www.parisphoto.fr 

Agnolo Bronzino: en.wikipedia.org/
wiki/Bronzino

IPA: photoawards.com 

www.christiantagliavini.com

The 1503 Series



1503, Lucrezia



1503, Ritratto di giovane uomo 
con cappello piumato

1503, Ritratto di signora in verde



1503, Bartolomeo

1503, Donna Clotilde

Christian Tagliavini | Portfolio



With the introduction of the reasonably-priced Nikon D610, Canon EOS 6D 
and Sony Alpha models, full-frame digital photography has finallly hit the
mainstream, making it possible to shoot pro-resolution images with a camera
that costs around US$2,000. But is price the only yardstick? We take a look at
the potential benefits of switching and why you might be better off sticking to
what you know. 

Sophia Sieber

Full-frame
for beginners and experienced APS-C users



Before the 2012 Photokina show,
full-frame digital cameras were the

preserve of photographers on a big budget.
True to the assumption that pro technology
comes at a pro price, back then, you had to
pay at least US$3,500 for a full-frame camera
body. And that was when the new era began,
with both Nikon’s D600 and the Canon EOS
6D hitting the market near the psychologically
important US$2,000 price point. 

It wasn’t long before the market did its
usual trick and the D600 could be found for
around US$2,200 with a lens included. Its
successor, the D610, now costs around the
same. More recently, market leaders Nikon
and Canon have encountered new
competition in the shape of Sony’s Alpha A7,
which is already available for under US$2,000
with a kit zoom.

What’s in store in 2014

We believe that prices will sink further in 2014
and that the major manufacturers will
continue to introduce new mid-range
full-frame models to make the most of current
consumer interest. Figures from last August
confirm that more than 30 per cent of DSLR
turnover in 2013 was made with full-frame
models, although it has to be said that the
absolute number of cameras sold was
minuscule compared with the market as a
whole. 

Rumors that sony is working on additional
mirrorless full-frame models as small as the
NEX-5 are backed up by patent filings
published on the Egami blog site. Other

manufacturers are sure to follow suit: it wasn’t
long ago that a listing for a camera called
‘NXF1’ was spotted on the Samsung website
and the rumor mill immediately assumed that
‘F’ stands for ‘full-frame’. So far, Samsung has
only built APS-C sensors into its mirrorless
cameras. 

Rumors also abound that Pentax is
preparing to enter the full-frame market. 2014
certainly feels like the right time to do so. We
have also heard from a reliable source that a
big-name camera manufacturer known for its
small-sensor cameras is planning to use full-
frame sensors and possibly even develop its
own. 

Reasons to Switch and Reasons
to Stick to Your Current System
In the current market, switching to full-frame
is a tempting proposition, especially when
you consider that most high-end APS-C
systems cost about the same as the current
crop of full-frame offerings.  

But things are never as simple as they
might seem, and the relatively low cost of
stepping onto the full-frame ladder is quickly
put into perspective by other factors. The
following pages provide an overview of the
benefits and potential drawbacks of making
the switch. 

Less Noise, 
More Dynamic Range
This is a clear yes factor. If you are not
prepared to make compromises and your aim

is to achieve the best possible image quality,
then full-frame is the way to go. Full-frame
sensors have a greater surface area than
APS-C and Micro Four Thirds models and
therefore offer a much greater area per pixel
for capturing incoming photons. The more
photons a sensor captures, the more image
data the resulting image file contains. 

Larger photoreceptors also mean less
image noise and greater dynamic range,
making it easier to capture great-looking
images in tricky situations such as low light
and backlight. 
But: No buts in this respect! Lower noise and
better contrast are always a bonus. 

Creative Scope

Another resounding yes. Full-frame
photographers have much more freedom
when it comes to composing and framing
their photos. They also benefit creatively from
the comparatively shallow depth of field
available at comparable focal lengths, which
makes it easier to use differences in focus as a
stylistic device. See our article Getting it Right
by Doing it Wrong in Issue 15 of c’t Digital
Photography for some ideas on using depth of
field effects creatively. 

Compared with small-sensor cameras,
full-frame models have a larger angle of view
at shorter focal lengths. This difference is
expressed in terms of the ‘crop factor’ – a
number that uses the 24 x 36mm full-frame
format as its reference point. In other words,
a full-frame sensor has a crop factor of 1, while
APS-C cameras come in at approximately 1.5
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Market Overview | Full-frame Special

Collecting Photons

Each pixel in the Canon EOS 
6D‘s 20-megapixel 
full-frame sensor has a 
nominal width of 6.5 μm. 
The APS-C Sony A3000 has 
a 20-megapixel sensor too, 
but with photoreceptors 
that measure only 4.3 μm. 
In comparison, the pixels in 
the sensor built into the 
Casio EX-ZS30 measure 
1.2 μm. 

Larger pixels can capture 
more photons and produce 
more image data. 1.2 μm  4.3 μm 6.5 μm



and micro Four thirds models at 2. A crop
factor of 1 is of particular benefit in wide-angle
situations, as it enables you to shoot with a
wider angle of view using a lens with the same
angle of view as an equivalent lens built for
use with smaller sensors. 
But: Greater creative potential also
demands more careful composition,
especially when it comes to shooting
portraits. If the plane of focus is in the wrong

place, the image will be ruined. If you are
working with a full-frame camera at wide
apertures, you will definitely need a tripod
and a patient subject! Photographers
making the switch from a smaller-sensor
camera are sure to produce quite a lot of
unusable images in their first few weeks
with a new full-frame camera. 

If you like to shoot using telephoto lenses,
you will have to get used to using much

longer focal lengths, which brings us neatly to
our next point.

More and Better Lenses

Another clear yes. Both Nikon and Canon
offer only a limited range of dedicated APS-C
lenses and concentrate heavily on their
full-fame offerings. Full-frame lenses are
generally of better quality and have larger

20 c’t Digital Photography 16 (2014)

Comparing Sensor Sizes

APS-CMicro Four Thirds1/2.3" Full-frame

Interchangeable-lens cameras come in a range of shapes and sizes with image sensors to match. Tiny 1/2.3” sensors are 
more often found in compacts than in system cameras. The undisputed king of the hill for most semi-pro and serious amateur
photographers is still the 24x36 mm full-frame format. This format is also widely used in professional circles, although many
pros also use cameras with medium-format sensors that measure 48x36 mm or more.

The EOS 6D is Canon’s current
calling card in the full-frame
world and, unlike the Nikon
D610, has built in Wi-Fi
functionality

Full-frame Special | Market Overview

The D610 is Nikon’s second-generation entry-level
full-frame model, although the differences between 
the new model and its predecessor are only slight 



maximum apertures than their APS-C and
Micro Four Thirds counterparts, so the
resulting images look more detailed and
three-dimensional. Another big bonus is that
you can use all those wonderful manual lenses
that you collected in the course of your analog
photo career, often without even having to
use an adapter.
But: Although they don’t have to make as many
compromises, full-frame photographers have
to spend more money to get the quality they
want. High-quality, bright telephoto lenses for
Micro Four Thirds cameras start at about
US$700, but you won’t find anything similar in
the full-frame camp for less than US$1,000.
Keeping a full-frame kit up and running 
requires careful planning, not least because the
higher quality of full-frame lenses makes them
larger and heavier and therefore less easy to
carry. 

The ability to use legacy lenses is, in
principle, a real bonus, but the genuine
advantages depend on which lenses you own
and their suitability for use with today’s
technology. Many older ‘bread and butter’
lenses were designed with the much lower
resolution of analog film in mind. Additionally,
while there is nothing but air in the space
between the lens and film in an analog camera,
digital cameras have various glass-based filters
positioned in front of the sensor that can
produce unwanted diffraction blur at the edges
of the frame when used with non-dedicated

lenses. Every additional layer of glass can also
produce unwanted internal reflections, which
can further diminish image quality. 

Conclusions

Of course, owning a pro-grade camera
doesn’t guarantee pro-grade results. The
freedom that using full-frame gear provides
also demands that you work carefully and
precisely at all times. The follow-on costs 
of expanding your lens collection are not
inconsiderable and your photo bag will be
much heavier than those of your colleagues
who use APS-C or Micro Four Thirds systems.
These considerations are especially relevant if

you like to shoot with telephoto lenses, as
crop-format cameras enable you to shoot
narrow angles of view with shorter, lighter
lenses that are mostly cheaper too. 

Consider as well that sensor technology is
still developing fast, and that smaller
back-illuminated sensors can now produce
images with levels of noise that are
comparable with those produced by larger
sensors just a year or two ago. Other
technologies, such as the Fujifilm ‘X-Trans’
sensor use unvconventional microfilter
designs to coax better image quality from
smaller sensors. The choice is yours, so have
fun shooting with whichever format you
decide to use. (ssi)
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Full-frame DSLR 
Market Overview

The market for full-frame 
digital cameras is not yet 
overly crowded and the 
available devices are not 
as diversified as those 
in the APS-C world. 
Nevertheless, the number 
of sub-US$2,000 full-frame 
cameras on the market 
has gone from zero to four 
within the last year.

Higher price

Entry- level

Moderate
resolution

High 
resolution

Canon EOS 6D

Canon EOS 5D Mk. III

Canon EOS-1D XNikon D4

Nikon Df

Leica M

Sony A99
Sony RX1 Nikon D800 (E)

Sony A7R

Nikon D610
Sony A7

Full-frame at a Glance:

Advantages:

–ˇBetter image quality

–ˇMore creative freedom

–ˇLarger angles of view 

–ˇGreater range of high-quality lenses

Disadvantages:

–ˇFollow-on costs

–ˇHeavier

–ˇShorter telephoto range

–ˇSteep learning curve

c
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Seven might just be Sony’s lucky number. The new Alpha 7 and
Alpha 7R models combine high-performance full-frame sensors with
compact mirrorless bodies and competitive prices. This article takes
the newcomers for a spin and takes a guess at just how scared
Nikon and Leica should be.

Thomas Saur und Sophia Sieber  

The New Sony Alphas
Taking Aim at the DSLR World



With its new Alpha models, Sony is
simultaneously piling on the pressure

in multiple market segments. Primarily, by
pricing the 24-megapixel, full-frame A7 on a
level with the SLT-A77, Sony appears to be
aiming directly at the high-end hobby and
semi-pro sector.

However, this move also places the new
cameras in direct competition with the Nikon
D610 and Canon EOS 6D. The A7 not only
gives conventional DSLRs a run for their
money, but also takes aim at the mirrorless

system camera market currently dominated
by cameras like the Olympus OM-D and 
the Fujifilm X-Pro1, both of which offer
significantly smaller sensors and a weaker
feature set for about the same price. And we
all know that consumers often make
price-based decisions true to the motto, “To
have is better than to want”.

Thanks to its high level of flexibility with
regard to lens adapters (see page 34), the
Sony also offers the US$7,000 Leica M
full-frame rangefinder camera some stiff

competition and, at the top end of the DSLR
market, the Sony A7R, with its 36-megapixel
sensor, is squaring up to pro-grade models
like the Nikon D800E.

Sony’s newcomers have generated a lot of
interest, so we decided to give them a
thorough c’t test and compare real-world and
lab performance with that of the established
competition. And, in view of the small number
of full-frame E-mount lenses, we tested them
with a range of adapters and third-party
lenses too.
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Sony A7
The Sony’s full-frame sensor has a relatively
modest count of 24 megapixels and uses a
hybrid autofocus system that comprises 117
phase-detection and 25 contrast-detection
focus areas. This system has already been tried
and tested in the NEX-series mirrorless
cameras and is designed to make focusing

faster and more precise. Much of the mirrorless
competition uses purely contrast-based
autotfocus systems that continually adjust the
focus setting until the camera’s processor
decides that maximum contrast between
neighboring pixels has been achieved. The A7
has a rich feature set that includes Wi-Fi and

NFC connectivity. The 3-inch,  921,600-dot TFT
monitor can be tilted up and down and the
OLED viewfinder has 2.36 million dots of
resolution. The top plate and the sensor unit
are made of magnesium alloy. The current
street price for the A7 body is around US$1,700
and is getting cheaper all the time. 

ISO100 | 55mm | f8 | 1/3s

Im
ag

e:
 O

rc
h

id
s 

at
 t

h
e 

H
er

re
n

h
au

se
n

 R
o

ya
l G

ar
d

en
s 

in
 H

an
n

o
ve

r

Leica M240
As a rangefinder camera, the Leica M is unique
among today’s full-frame digital offerings. It has
a 24-megapixel sensor and uses a completely
manual focusing system. In contrast to the other
models we tested, the Leica is anything but fast
and is designed with a more philosophical
approach to photography in mind. The bright

frame split-image focusing system requires a
high degree of skill and concentration on the
photographer’s part, and focusing on a portrait
subject’s eye, for example, involves adjusting
the focus ring on the lens until the the contours
of the eye perfectly match the overlaid image in
the viewfinder. Thanks to live view, you can

compose your image via the monitor too, which
is simpler and, for many users, a more familiar
approach. Although it is about the same size as
the A7, the top and bottom plates are made of
solid brass, making the M a lot heavier. The
Leica’s price is exotic too, with a current street
price of around US$7,000 for the body alone.

ISO200 | 50mm | f8 | 1/8s

In an initial comparison under ideal conditions at ISO 100, the A7 produced really sharp images …

… but the Leica still delivered a more vivid overall look
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Sony A7R
Although identical in many ways, the A7R
differs from its little sister in that it has a
36-megapixel sensor and no low pass filter.
This approach is intended to maximize the
system’s potential resolution. Low pass (or
‘anti-moiré’) filters are designed to reduce
the incidence of moiré effects in digital

image capture systems. However, such a
filter reduces the sharpness of the captured
light rays in order to make it possible for 
the camera’s circuitry to interpret them,
which inevitably reduces overall resolution
and the sharpness of the resulting images.
This model bridges the gap between

mirrorless and pro-grade cameras. In spite 
of its less capable 25-point contrast-
detection based AF system, the A7R has
more magnesium components than the A7
and is therefore more robust and slightly
lighter than its sister model. Both models are
dust and moisture resistant.  

Nikon D800(E)
Up until the introduction of the Sony A7R, the
Nikon D800 models were the undisputed
leaders in the full-frame megapixel stakes. Like
the Sony, both Nikons offer a 36-megapixel
sensor, and the ‘E’ version has no low pass
filter. Their enormous resolution even turns
the D800E and the A7R into competitors for

some pro-grade medium-format cameras. The
Nikon has a 51-point phase-detection AF
system that is typical for this type of high-end
DSLR. Logically, it has an optical viewfinder
but can also be used in live view mode. Its
3.2-inch, 921,000-dot monitor offers 100%
coverage but is not articulated. Unlike 

the Sonys, the Nikon offers neither 
Wi-Fi nor NFC connectivity. It weighs 1,000
grams (2 lb 3.3 0z) with the battery and a
memory card installed and currently costs
about US$3,300 for the ‘E’ version and
US$2,900 for the standard version (both
prices are for the body only). 

… and D800E produces images with an almost HDR-style look

The huge range of contrast captured by the high-resolution sensors in the A7R … ISO100 | 55mm | f8 | 1/3s

ISO100 | 50mm | f8 | 1/2s



26 c’t Digital Photography 16 (2014)

Full-frame Special | Sony A7 vs. the Competition

ISO Comparison
You have to use a magnifying glass to find the
differences between these images. In general,
and contrary to popular opinion, sensors with
fewer megapixels don’t necessarily produce
better results. All four of our test cameras show
excellent signal-to-noise and visual noise

characteristics. Overall, the Sony results were
slightly better than those of the D800,
although not enough to make any real
practical difference. The A7 recorded a
signal-to-noise value of 97 at ISO 100, while
the A7R reached an unprecented reading of

104. A visual noise value of 0.7 for both models
is on a par with the EOS 5D Mark III and the
Nikon D4. Some slight artifacts were just visible
at ISO 6400 for both Sonys, but had a
negligible effect on our subjective perception
of image quality.

ISO100 Sony A7 Sony A7R Leica M (ISO200)

ISO400 Sony A7 Sony A7R Leica M

ISO800 Sony A7 Sony A7R Leica M

ISO1600 Sony A7 Sony A7R Leica M

ISO3200 Sony A7 Sony A7R Leica M

Nikon D800E

Detail of the label on a wine bottle, shot in the Meyers Hof restaurant at the Hannover Adventure Zoo

Nikon D800E

Nikon D800E

Nikon D800E

Nikon D800E



The image reproduced
here is a detail of a
high-ISO shot. The full
image, captured using the
Sony A7R, measures
about 300 x420mm
(12 x16.5 inches).

ISO8000 | 55mm Zeiss Otus |
f1.4 | 1/8000s
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Thanks to the nicely shaped rubberized grip,
the new Alphas are a pleasure to hold and use
and, in spite of their diminutive size, offer a
shooting experience that lags only slightly – if
at all – behind that of full-blooded DSLRs like
the D800.

The top plate and camera back are packed
full with buttons and dials but nevertheless
manage not to appear too busy. The overall
concept provides intuitive handling and a
great deal of photographic freedom.

Alongside the obligatory mode dial, there
is a dedicated exposure compensation dial
and two further dials that have varying
functions depending on the current shooting
mode. Nearly all the dials and major buttons
(including the mode dial) can be assigned
custom functions.

Pressing the ‘Fn’ button dipslays all the major
shooting parameters on a single screen and
again, the user can customize the layout and
decide which settings to display. This makes it
largely unnecessary to scroll through the menus
themselves, although they are clearly arranged,
either as a list or in a practical tiled view that
bundles sets of functions for access via dedicated
icons. What this means is that functions such as
ISO sensitivity, image size and self-timer are not
distributed among various menus the way they
are in the NEX-series cameras – in our view, this
is definitely a change for the better. 

Wi-Fi Control

Built-in Wi-Fi and NFC connectivity set these
cameras apart from most of the direct

Handling

Switches
The major functions can be
assigned to many of the buttons
and dials. The dedicated
exposure compensation dial 
is a nice  touch.

Sensor
The latest Sonys
are the first 
E-mount cameras
with full-frame
sensors. All earlier
E-mount cameras
have APS-C
sensors.

Card Slot
The SD card slot is practically
located behind a door on the
back of the grip, which makes it
easy to access, even if the camera
is tripod-mounted

Menus
The list-style default
menu system will be
familiar to Sony users,
and there is a 
cleaner-looking tiled
view option too.
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competition. The available functions include
easy image sharing as well as remote camera
control via your smartphone. If you have an
NFC-capable smartphone with the
PlayMemories Mobile app installed,  bringing
the two devices together at the touch point
marked on the right-hand side of the camera
body is all it takes to build a connection. We
tested this using an G2 from LG, and it
worked perfectly first time. If your mobile
device isn’t NFC-enabled, you have to enter
a password generated by the camera in the
app interface. 

Remote control worked smoothly via
Android 4.3 on our LG and on an HTC
Sensation XE running Android 4.0.2, although
the app did crash now and again on the older
device. The remote control functionality

provided by the app is fairly basic and could
do with improvement, especially with 
regard to manual-focus lenses (see page 30).
Remotely captured images are stored as
scaled versions on the smartphone, while RAW
images aren’t stored on the mobile device at
all. Image files captured using the camera and
sent to a mobile device via Wi-Fi or NFC are
transferred at full JPEG resolution.  

Wi-Fi functionality can also be used to
download other apps from the PlayMemories
Camera Apps Store, provided you register on
the Sony Entertainment Network first. The
Smart Remote Control and Direct Upload apps
are the only ones available now, but Sony
promises to add multiple expsosure, lens
compensation, retouching and picture effect
apps soon.

c’t Digital Photography 16 (2014) 29

LCD Monitor
The tiltable LCD screen is an
unusual feature in a camera with
pro-grade ambitions

Robust Body
The new Alphas are dust and moisture
resistant. The top and front plates in
the A7R are made of magnesium alloy.

Wi-Fi
Built-in Wi-Fi functionality makes it
possible to control the camera
remotely using a smartphone or tablet



Landscapes with the A7R
The high resolution and great detail rendition offered by the
A7R make it an interesting option for landscape photographers
who rely on their gear producing excellent results into the very
corners of the frame. Like the Nikon D800E, the A7R only fulfills
its real potential if used with top-notch lenses. Used carefully,
the A7R almost reaches the same quality of detail rendition as
the medium-format Hasselblad H4D-40 that I usually use,
although the Hasselblad’s 16-bit processor still offers finer color
nuances. In contrast, the Alpha cameras score highly with their
small size and light weight. 

On the downside, Sony’s remote control functionality is a
disappointment and doesn’t make the most of the potential of
transmitting a real-time live view image to an iPad or other
mobile device, and the function only works with Sony’s own AF
lenses. Such an option is much more important for manual focus
lenses, so Sony definitely missed a trick there. Additionally, the
Sony software doesn’t enable pixel-level image viewing under
iOS, so you have to install the (free) Actual Pixels app to zoom in
to a 100% view. On Android, the standard photo viewer does the
job admirably without the need for additional software. If Sony
improves its remote control software offering, it would have
another convincing selling point that would save potential
buyers the US$300 it costs to add remote control functionality
to the D800E using the CamRanger wireless transmitter. 

Conclusions 
To really gain acceptance, Sony will have to introduce some new,
small-sized lenses that make the most of its sensors’ capabilities.
The current third-party lens/adapter solution wastes a lot of the
camera’s potential and, if you add the cost of a high-quality lens
adapter to the price of the camera, there is virtually no difference
between the A7R and the D800E. (Stefan Arand)

ISO100 | 20mm | f11 | 1/40s | Nikon 12-24mm

Full-frame Special | Shooting Landscapes with the Sony A7R
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The A7R in the Studio
Handling: The A7R offers fantastic functionality in a really small
package. Exposure time, aperture and exposure compensation
can all be set using dedicated dials, giving the camera a highly
analog feel. In contrast to Sony’s NEX mirrorless models that force
you to scroll through apparently endless menus to adjust most
key functions, the Alpha also gives you the option to assign major
functions to the Fn button. 

The downside of all this variety is that it is too easy to lose track
of what you have set where and, for example, end up using the
wrong ISO setting. I also found that the online help didn’t
describe the available functionality in sufficient detail and the
documentation for the available apps is simply bad. An X-Sync
flash socket would also help to persuade semi-pro and pro users
to consider using the A7 models.  

The monitor zoom function and the excellent viewfinder are
great manual focusing aids. Pressing the C1 button immediately
displays an enlarged detail of the viewfinder image, making
manual focusing a snap.

Especially for wide-aperture portrait shots in which focus
needs to be precisely located on the subject’s pupil, I found
focusing this way to be much more accurate than it is using an
optical viewfinder or even autofocus. The quality of the monitor
and the viewfinder are quite sufficient for judging focus
accurately, which cannot be said for most current digital
medium-format cameras. 

At the time of writing, there were very few lenses available for
testing autofocus speed in fast-moving fashion and people
photography situations. Used with the Sony/Zeiss FE 55mm f/1.8
lens and the Sony 70-200mm f/2.8 G SSM II (with the help of the
LA-EA4 adapter), the system made a very good first impression
without actually breaking any speed records, although the 55mm
lens quickly reached its limits when shooting a dancing model in
burst mode. 

The camera’s tethered shooting mode, enabled using the free
Remote Camera Control software, proved extremely useful. You
only have to remember to set the camera to ‘PC’ mode to get it
to work. The remote connection to our MacBook Pro remained
stable throughout our test.

Image quality: Viewing the
RAW files captured by the tiny
camera on a large monitor is a real
joy. Resolution, color fidelity and
dynamic range are among the best
offered by today’s full-frame
cameras. The extremely broad
tonal range of the Sony’s images
enabled me to squeeze all sorts of
effects out of my images during
RAW development, using shadow
and highlight detail that is simply
not there in images captured by
most other DSLRs. 

The quality of the A7R’s RAW
files is directly comparable with
those produced by the Nikon

D800E, and the Sony images were slightly more detailed than the
Nikon’s when developed using exactly the same Lightroom
settings. On the other hand, the Nikon seems to produce slightly
cleaner signals at low sensitivity settings, which enabled us to
sharpen our Nikon images more than those from the Sony
without producing any unwanted artifacts. The details produced
by the Sony at ISO sensitivities  between 1600 and 2000 is
excellent and is perfect for shooting spontaneous handheld
portraits with a deliberately slightly grainy look. 

Lenses: The Sony sensor’s high resolution presents even the
very best lenses with a serious challenge. Used with a Metabones
adapter, many Canon L-series and Zeiss ZE lenses produce
hitherto unseen quality, while high-end lenses like the Zeiss Otus
(which we will be reviewing in the next issue of c’t Digital
Photography), transform the Sony into a real pro-grade image
capture system that offers a genuine alternative to medium
format. 

The relatively inexpensive SEL 28-70mm lens that Sony is
selling as part of the standard European A7 kit simply wastes the
camera’s potential, producing images that are not really sharp at
the edges, even stopped down. On the other hand, the
Sony/Zeiss FE 55mm f/1.8 is one of the best standard lenses
around, producing lovely bokeh wide open and pin sharp images
when used slightly stopped down. The FE 35mm f/2.8 is another
very good prime lens that produces excellent results in everyday
use. We were given two 35mm sample lenses to test, and the
differing results they produced infers a relatively high degree of
deviation in the manufacturing tolerances. 

Conclusions

The Sony A7R is well suited to portrait photography, product
photography in the studio and for fine art shots. If Sony manages
to deliver more lenses at the same quality level as the FE 55mm
f/1.8, they are sure to have a winner on their hands, especially
among photographers who prefer using compact gear. The
quality of the software and documentation are not good enough
and still need improvement. (Thomas Saur)

ISO50 | Zeiss Otus 55mm | f5.5 | 1/60s
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Canon
Metabones Canon EF Adapter III
(US$400)

The Metabones adapter supports
aperture and autofocus as well as the
transmission of metadata (see
www.metabones.com for a list of
supported lenses). We had no issues
using the adapter with L-series and
manual focus lenses in a range from
14-135 mm, and even the wide-angle
models produced images that were
sharp right up to the edges. The only
drawback is the slightly slower and 
less precise autofocus.

Canon 85mm f/1.2L 
ISO2000 | 85mm | f1.2 | 1/8000s

Leica M
Novoflex NEX/Leica M (US$250)

Leica M-series lenses offer a compact
and attractive range of additional
lenses for the Sony (see this issue’s
cover for an example). However, care 
is required when using focal lengths
below 50 mm, as these produce
suboptimal edge and corner definition
along with vignetting and color errors.
To avoid these issues, you have to stop
down further than you would when
using a Leica camera. If you want to
use the Sony camera with M-series
lenses, be sure to test the combination
you plan to use before shooting.

34

M42
Novoflex NEX/M42 (US$160)

An M42 adapter transforms these
hyper-modern cameras into a testbed
for all sorts of legacy glass. The range
of pre-owned M42-mount lenses
available on eBay and elsewhere is
enormous, although many of them
simply don’t do justice to the camera’s
extremely high resolution. The A7R
immediately shows any lens
weaknesses to their worst advantage,
which is a shame – especially when it
comes to using old favorite lenses.
However, if you take the time to
experiment, you might just as easily
capture some pleasant surprises.

Third-party Lenses and Adapters

M42 Pentacon 135mm f/2.8 
ISO6400 | 135mm | f2.8 | 1/250s

Leica 24mm f/1.4 SUMMILUX-M ASPH
ISO2000 | 24mm | f5.6 | 1/200s
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Nikon
Novoflex NEX/Nikon (US$300)

Our tests with Nikon lenses produced
some very mixed results. Some were
excellent, but handling with the A7R
took a lot of getting used to, especially
when it came to aperture control. The
well-made Novoflex adapter has a
built-in but unlabeled aperture ring
and, because the adapter transmits
neither aperture nor Exif data, we
ended ‘flying blind’ while shooting and
during processing. During our test
shoot, we used a second (Nikon)
camera to help us guess exactly which
apertures we were using!

Sigma 35mm f/1.4 DG HSM for Nikon
ISO2000 | 35mm | f2.8 | 1/200s

Sony
Sony LA-EA4 (US$350)

We were given the Sony LA-EA4 
A-mount/E-mount adapter to test just
before this issue went to print. Like 
all the models mentioned here, the
adapter’s build quality is excellent. 
We tested it with the Sony 70-200mm
f/2.8 G SSM II, which produced 
pin-sharp results stopped down 
but rather soft images wide open.
Autofocus worked quickly and reliably,
although it wasn’t as fast as the native
NEX/Alpha systems.

Sony 70-200mm f/2.8 G SSM II
ISO100 | 200mm | f5 | 1/800s

Sony’s new A7 and A7R models have caused
a real stir in the market and put a new kind of
pressure on Canon and Nikon, although
overall mirrorless camera sales still lag behind
DSLRs on a consistent but low level. 

Conventional DSLRs still stand for high
image quality and well-developed handling.
The Sony NEX cameras have not yet been
able to make inroads into this market, which
is one of the reasons we might see the NEX
brand disappearing from the market in the
near future. Instead of attempting to create
an entirely new market segment, Sony’s
new strategy is obviously to establish its
high-end mirrorless cameras as a real
alternative to traditional DSLRs.  

The Alpha 7 models are the first major
step along this route, combining mirrorless
technology with the naming scheme of
Sony’s other SLR cameras – a move that is
sure to break down some consumer
reticence when it comes to adopting the
mirrorless approach. 

Alphas Top of the Heap

In general, we were very impressed with the
new Alpha models, especially in view 
of their competitive price compared to the
current Canon and Nikon full-frame
offerings. Our lab-based and real-world 
tests produced superb results that plant
both cameras firmly at the top of their
respective megapixel classes. The icing on
the cake for most users will be the compact
size of this new pro-grade system and the
extremely flexible configuration options 
for the user interface. 

Still Some Compromises

But we at c’t Digital Photography remain 
true to form and found a couple of things
that we don’t like too. For example, the
viewfinder proximity sensor is much too
sensitive and switches off the live view if you
so much as wave a finger in the direction of
the eyepiece while you are using the
monitor to focus. Additionally, the camera’s
built-in Wi-Fi capabilities don’t make the
most of their potential and need to be
further developed and refined, especially
where remote manual focusing is
concerned.

Another drawback is the  extremely narrow
range of full-frame E-mount lenses and 
the  high prices of the available models. The
Sony/Zeiss T* 55mm f/1.8 costs around
US$1,000, compared with equivalent lenses

Conclusions
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from Canon and Nikon that cost around
US$200. Right now, this would appear 
to make the Sony system prohibitively
expensive for amateur and semi-pro
photographers who are considering the
switch to full-frame. 

On the other hand, the range of available
adapters and third-party lenses makes the
system almost endlessly extendable. As this
issue’s cover image shows, using the A7 with

legacy lenses and selected accessories (the
leather case comes from angelo-pelle.com)
can give you a really attractive-looking setup
that guarantees great results. 

But this is where the compromises start.
Most other manufacturers’ lenses simply
cannot do justice to the Sony sensors’
enormous resolution and produce poorer
results with the A7s than they do with their
native camera brands. This issue is

The A7 looks more like an
accessory when attached to 
an A-mount telephoto zoom

Who hid the camera? The current lack of 
full-frame E-mount lenses means you are
almost sure to end up using third-party
lenses and adapters
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CAMERA DATA
Technical Data

Sony A7 Sony A7R Leica M240 Nikon D800
Sensor resolution 6000 x 4000 7360 x 4912 5952 x 3976 7360 x 4912
Megapixels 24 36 24 36
Sensor size 35.8 mm x 23.9 mm 35.9 mm x 24 mm 36 mm x 24 mm 35.9 mm x 24 mm
Crop factor 1 1 1 1
RAW capture Yes Yes Yes Yes
Autofocus system Hybrid Contrast-based – Phase-detection
AF areas 117 phase-detection, 25 contrast-based 25 – 51
Shortest/Longest exposure time 1/8000 s / 30 s 1/8000 s / 30 s 1/4000 s / 60 s 1/8000 s / 30 s
Sensitivity ISO 100-25 600 ISO 100-25 600 ISO 200-3200 ISO 100-6400
Viewfinder OLED OLED Rangefinder Optical pentaprism
Viewfinder resolution 2.36 m dots 2.36m dots – –

Monitor LCD LCD LCD LCD
Monitor size 3-inch 3-inch 3-inch 3.2-inch
Monitor resolution 921,600 dots 921,600 dots 920,000 dots 921,000 dots
Monitor articulation Yes Yes No No
Dimensions (W x H x D) 127 mm x 94 mm x 48 mm 127 mm x 94 mm x 48 mm 139 mm x 90 mm x 42 mm 146 x 123 x 81 mm
Weight (w/ battery and mem. card) 474 grams (16.7 oz) 465 grams (16.4 oz) 680 grams (1 lb 8 oz) 1000 grams (2 lb 3.3 oz)
Memory card types SDHC, SDXC SDHC, SDXC SDHC, SDXC SDHC, SDXC, CF
Connectors Wi-Fi, NFC, Micro-USB, HDMI W-Fi, NFC, Micro-USB, HDMI Optional USB USB 3.0, HDMI
Current street price (Body only) US$1,700 US$2,300 US$6,950 US$2,800
Test Results

better> better> better> better>

Sensor resolution (line pairs)
Center resolution (ISO 100)1

Center resolution (ISO 400)
Center resolution (ISO 1600)
Center resolution (ISO 6400)
Dynamic range2 (ISO 100)1

Dynamic range (ISO 400)
Dynamic range (ISO 1600)
Dynamic range (ISO 6400)

< better < better < better < better

Visual Noise (ISO 100)1

Visual Noise (ISO 400)
Visual Noise (ISO 1600)
Visual Noise (ISO 6400)
Shutter lag at 1000 lux (in seconds)
1 Leica M ISO range begins at ISO 200                            –ˇnot included                            2 in f-stops

2000
1767
1761
1741

1667

2456
2553

2359
2452

2206

1984
1810

1760
1739

–

2456
2150

2017
1879

1741
10.2
10.4
10.3

10.1

12
10
10

9

10.5
10.4

9.98
–

10
9

8.7
7.7

0.7
1

1.1
1.6

0.7
0.9

1.2
1.8

1
1.3

2,1
–

0.8
1.3

2
3.1

0.28 0.44 – 0.19

epecially obvious for lenses with shorter
focal lengths. 

More expensive adapters deliver 
better performance but, at prices of US$400
and more, these negate the cheaper
purchase price of a Sony compared to 
the direct competition from Canon and 
Nikon. In other words, switching to
full-frame is still a costly undertaking
however you look at it. 

Actually shooting with third-party lenses
requires a lot of care and attention too, as 
only very few support autofocus, automatic
aperture control and Exif data transfer. 
Canon lenses offer the widest range of 
options and you should thoroughly test 
any Nikkor/adapter combination before
committing to a purchase. 

We also felt that using the diminutive A7
with the rather large LA-EA4 adapter and an

A-mount telephoto zoom completely
canceled out the camera’s size advantage.
Furthermore, we found ourselves worrying
that the extra leverage involved might
damage the camera’s bayonet. 

Sony has published an ambitious
roadmap for the future of the new Alpha
system and now needs to come good on its
promises if it wants to to see it becoming a
true world-beater. (ssi)

c



Asuper zoom as bright as this is unusual
enough, with the AF-S Nikkor VR

200-400mm f/4G ED  VR II and the Sigma
200-500mm f/2.8 EX DG APO IF offering the
only real competition. But what really sets the
new Canon mega-lens apart is its built-in
teleconverter – a feature that is unrivaled
anywhere. A lever on the lens barrel swings 
a separate lens group into the light path 
while you shoot, transforming this already
monster lens into an unparalleled 
280-560mm zoom with a constant maximum
aperture of f5.6.

Professional sports and wildlife
photographers often use fixed focal length
lenses and either switch shooting positions or
crop their images later to achieve the right
framing. Other ways of changing your
viewpoint also include switching lenses or
mounting a teleconverter between the lens
and the camera body. Zoom lenses are more
flexible but usually offer reduced optical
quality – and the longer the zoom range the
worse things get. Teleconverters are a good
compromise but reduce the effective
maximum aperture you can use and cropping

only makes sense if you have enough
resolution in reserve to produce sharp
reformatted images. Canon’s latest
super-telephoto zoom attempts to bridge 
the gap between pro-grade creativity and
everyday flexibility while retaining the
maximum possible image quality. The result
is a high-end, high-price, heavy-duty slab of a
lens.

The lens has many more controls than a
conventional zoom, some of which require a
little explanation. The built-in image stabilizer
has three modes: Mode 1 corrects vibrations
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Peter Nonhoff-Arps

Canon’s Mega-zoom
with a built-in 1.4x teleconverter

With its bright maximum aperture, built-in teleconverter, comparatively
small size and excellent reproduction quality, the Canon EF 200-400mm
f/4L Extender has a lot to offer. Quality has its price, and we decided to
take the US$12,000 beast for a spin.



in all directions, while Mode 2 enables the lens
to correct vertical camera shake during
horizontal tracking. In both these modes,
stabilization is activated as soon as you press
the shutter button halfway. In Mode 3, the lens
computes stabilization parameters for
stationary shots and pans when the shutter
button is pressed halfway, but only actually
compensates for them during the exposure
(i.e., once you have pressed the shutter button
all the way down).

Autofocus

The autofocus system covers a range from 2 m
to infinity and can also be limited to between
either 2-6 m or 6 m to infinity, which means
that the focusing elements don’t have to move
so far while they are in use, resulting in faster
focusing. Alongside conventional manual and
automatic focus modes, Canon has included
the ‘Power Focus’ mode that allows you to vary
focusing speed – a feature that is particularly
useful when you are shooting video. Power
Focus is controlled by the ‘playback ring’
located behind the ring that houses the AF
stop buttons. If you rotate it to the right, focus
adjusts toward the close end of the scale at a
constant rate and the further you rotate the
ring, the faster the rate of change of focus.

The Focus Preset switch is used to define a
point to which the lens focuses when you press

the shutter button halfway (or when you move
the focus ring in manual focus mode). Focus
Preset can be used in conjunction with Power
Focus to focus automatically to your
predefined point at constant speed.

The ring in front of the playback ring houses
four Focus Stop buttons that halt the current
focus action while pressed. This is useful if, for
example, an obstacle swings into view in the
middle of a pan.
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The built-in image stabilizer keeps
images sharp even when you use long
exposure times

The focusing distance range selector switch
limits the focus range to reduce autofocus
reaction times and speed up shooting
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Benny Rebel is an artist who lives up
to his name. He has been surprising
the European and internationl wildlife
photography scenes for more than
ten years with his unique and often
breathtaking wildlife photos. He now
specializes in organizing photo safaris
in Africa (www.Benny-Rebel.com). In
this interview, he shares his thoughts
on the subjects of fixed focal length
lenses, teleconverters and zooms.

c’t Digital Photography: Benny, what do
you consider to be the most exciting wildlife
subjects? 

Benny RebeI: I like images that play with
my emotions. Images that move or amaze
me, or that make me laugh and get me
thinking.

c’t: Do you prefer to use fixed focal length or
zoom lenses for your wildlife shots? 

BR: I like to use fixed focal lengths
whenever possible, as they usually deliver
better image quality than zooms. On the
other hand, zooms are more practical and
help me to compose my images on the fly.
At the end of the day, I tend to use a
mixture of both zooms and primes.
For example, if I am photographing a lion
at rest, a fixed focal length does the job
admirably, whereas if I am shooting a pride
of lions on a hunt from close up, the
flexibility a zoom gives me is more
important than that little extra bit of image
quality. 

c’t: How important are long focal lengths to
your work as a wildlife photographer? 

BR: The wildlife photos that made me
famous were shot using focal lengths
between 12 and 16 mm! However, this
doesn’t mean that I don’t use long lenses
too. On my safaris I use everything
between 15 and 500 mm.

c’t: Do you use teleconveters? 

BR: I’m not a big fan of teleconverters, as
they reduce image quality and therefore
the number of usable images I take home
from a shoot. They also reduce the
maximum available aperture. A 2x

converter halves the amount of light that

reaches the sensor. All the teleconverters I
have used have reduced the overall quality
of the lenses I used them with – some
more, some less. Image sharpness and
vividness especially suffer if I use a
teleconveter. Some converters also amplify
chromatic aberrations and vignetting
effects, and I have even tested converters
that cause color shifts. 
Overall, I have always found 2x converters
to be virtually useless for my purposes,
whereas some 1.4x models are of high
enough quality to consider using. On the
whole, though, I prefer not to use
converters at all. The latest full-frame
cameras deliver excellent image quality
and extremely high resolution, so it is often
preferable to use a cropped image than
one shot using a teleconverter. 

c’t: Would you consider using a high-end
zoom like the Canon 200-400mm f/4.0 with
its built-in extender? 

BR: As you have probably noticed, I’m not
keen on teleconverters, and I can’t think
why a built-in converter should be any
better than conventional ones. Having said
that, I haven’t yet had a chance to test the
Canon lens. For my purposes, a
200-600mm full-frame zoom with a
maximum aperture of f4 or f5.6 would be 
a more practical option than a
zoom/teleconverter combo. The only
problem here is that my dream lens
doesn’t actually exist!

c’t: What are the most important aspects of
the equipment you use? Speed? Quality?
Weight? Size? Robustness? 

BR: I work in the wilderness in Africa, where

it is almost always hot and dusty and my
gear is constantly being shaken up by
bumps and ruts in the roads through the
wildlife reserves that I visit. Robustness is
therefore just as important to me as image
quality. Additionally, the smaller and
lighter my gear, the less energy I require 
to use it. Speed is, of course, extremely
important for action scenes. In some
situations, a camera can never be fast
enough.

c’t: Do you use tripods too? If yes, which
ones? 

BR: I really love high-quality, heavyweight
tripods and quality heads and I always use
one if I can. Shooting from a tripod always
produces sharper, more vivid images and
forces you to concentrate on your subject
and take more time to compose your
images. The result is usually better work. 

c’t: Have you ever found yourself having to
improvise becaue you were out and about
with the wrong gear?

BR: I plan my safaris very carefully and
don’t usually forget anything. However, in
Africa, everyone has to improvise now and
again.

If you want to earn money with wildlife
photography, it is essential to learn about
the behavioral patterns of the creatures
you wish to photograph. If I can guess
what my subject is going to do next, I
usually end up in the right place at the
right time and capture the best possible
images.

An Interview with Wildlife Photographer Benny Rebel

Benny Rebel is
famous for his
animal portraits
shot at really
close distances
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Hanuman langurs photographed at the Hanover Adventure Zoo

Canon EOS-1D X with the EF 200-400mm f/4L IS USM Extender 1.4x

set to 560mm | ISO200 | f8 | 1/320s | Tripod-mounted



The most interesting feature is, of course,
the built-in 1.4x teleconverter. The additional
lens group is housed in the bulge on the rear
left-hand side of the lens barrel and is moved
into the light path using the built-in lever. The
lens automatically transmits the modified lens
data to the camera’s firmware. Our test with
an EOS-1D X worked faultlessly, although the
user manual does include a long list of
warnings about potential failures that can
occur if the lens is used with particular camera
bodies. 

In Use in the Real World

We headed off to the local zoo to take some
test shots and took the precaution of taking a
robust tripod with a ball head with us to
support the almost 5 kg (11 lbs) that this
particular camera/lens combo weighs.

The fast autofocus and high burst shooting
rates provided by the EOS 1D X make an ideal
testbed for the lens, which impressed us with
AF reaction times to match the camera’s

capabilities and excellent image stabilization.
We managed to capture a surprising number
of really sharp images, even at high burst rates
and using relatively long exposure times. 

Contrary to the warnings printed in the
user manual, we were able to move the
extender in and out of the light path while
shooting without causing any ill effects. The
wide maximum aperture provides a bright,

clear viewfinder image for normal focusing
and we were able to use the Magnify function
in Live View to squeeze the very last drop of
sharpness out of manual focusing situations.

The test shots we made in the lab
(included on this issue’s free DVD) show that
sharpness is even and balanced all the way to
the edges of the frame, and we only recorded
very slight vignetting at maximum aperture.
The lens produced maximum sharpness
between f8 and f11 (with and without the
extender), while performance dropped off
noticeably at f16 and below. We also noticed
that our EOS-1D X overexposed ‘extended’
images slightly in the lab, but not in our
outdoor test shots.

Conclusions

The EF 200-400mm f/4L IS USM 1.4x Extender
offers pro photographers a high degree of
quality and convenience but Canon charges
nearly US$12,000 for the privilege. For working
professionals, the costs involved in purchasing
(or renting) this lens are sure to be amortized
quickly by the extremely high-quality results it
is capable of producing. The useful zoom
range also makes multiple high-quality fixed
focal length telephotos redundant and could
actually reduce the overall size and weight of
your camera bag. (pen)
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CANON EF 200-400MM F/4L IS USM 1.4X EXTENDER
w/o Teleconverter w/ Teleconverter

Aperture range f4.0- f32 f5.6- f45
Focal lengths 200-400 mm 280-560 mm
# of aperture blades 9 
Tested at1 Wide open / Stopped down (-2 EV)
Center resolution 1718 lp/h / 1690 lp/h 1683 lp/h / 1665 lp/h
Edge resolution 1635 lp/h / 1688 lp/h 1530 lp/h / 1614 lp/h
Vignetting 0.8% / 0.1% 0.9% / 0.1%
Chromatic aberration 0.3 pixels 0.6 pixels
Distortion 0% 1%
MRSP US$11,800
1At medium focal length c

The lever at the rear of
the lens barrel swings
the teleconverter into
the light path. The extra
lens group can be
activated at any time.

Center                              Top left Center                              Top left

Center                              Top left Center                              Top left

f4.0 f11

f5.6 (with 1.4x Extender) f11 (with 1.4x Extender)
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George D. Lepp and Kathryn Vincent Lepp

Focus Stacking
Expand Your Macro Depth of Field

Macro photos often have extremely shallow depth of field. The
most effective way to work around this limitation is to capture
multiple source images with different planes of focus and merge
them into a single image with enhanced depth of field using a
technique called focus stacking. In this article, renowned nature
photographer George D. Lepp explains the basics of focus
stacking and demonstrates how to use it to create fascinating
close-up images.
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Macro, or high-magnification, photography
is aesthetically extremely  rewarding.

Whether botanical, biological, or mechanical,
ordinary subjects are rendered unique when
seen from a high-magnification perspective.
For the photographer and the viewer of 
such images, the revelation of intricate
details usually indiscernible to the human
eye yields both new understanding of 
small subjects and appreciation of their
compelling composition, design, and color –
the essential components of a successful
photograph.

Anyone who has attempted close-up or
macro photography has encountered the
problem of limited depth of field: the area
of the image that appears acceptably sharp
diminishes as the magnification increases.
While the subject may be highly magnified,
only a tiny portion of it is sharply detailed.
At 1x (i.e., life-sized), only a 1.5mm slice of
the image will be in sharp focus at f11.
Increase the magnification to 5x (f5.6) and
the zone of focus is reduced to a minuscule
0.095 mm. There are a number of ways to
increase the range of sharpness, including
stopping down the lens, using a tilt/shift
lens to apply the zone of focus more
efficiently and focus stacking. The latter is a
product of the digital age and definitely
offers the best results.

Focus stacking is a digital editing process
that combines a series of images captured at
overlapping depths of field to expand the
zone of focus in the resulting photograph. A
variety of programs can be used for assembly,
including Zerene Stacker, Helicon Focus and
Photoshop. While the term ‘focus stacking’
generally refers to the act of compositing the
images, generating the high-magnification
source images is by far the most complex
aspect of the technique.

The Challenges

All serious photography presents challenges
that have to be met if the photographer’s
vision and purpose are to be successfully
achieved. In the case of high-magnification
photography, limited depth of field isn’t the
only problem. Resolution and sharpness

depend on the quality of the camera and lenses
used and on how well they are employed. It is
essential to completely eliminate movement of
both camera and subject so that the focus
slices match properly during assembly. Getting
sufficient light on the scene and controlling
movement almost always requires the use of
electronic flash with a very short duration.
Positioning flash is complicated, too, due to the 
minimal working distances involved. Macro
equipment requires a solid footing so that
focus, the camera and the subject can each be
precisely moved through the focus zones. At
higher magnifications, these considerations
become even more critical and require
increasingly complex interventions. And, as
always, composition counts. You need a strong
subject, color, and/or design element with no
distracting background and controlled lighting
to create mood or add emphasis.
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A unique perspective on 
a group of unusual and
highly detailed U.S.
coins, attained by
compositing nine
stacked images with
overlapping depth of
field captured at 1x

magnification 

ISO200 | Canon MP-E 65mm
macro lens | f16 | 1/250s 

Depth of Field when Using the Canon MP-E 65mm f/2.8
In millimeters
Magnification f2.8 f4 f5.6 f8 f11 f16
1x 0.396 0.560 0.792 1.120 1.584 2.240
2x 0.148 0.210 0.297 0.420 0.594 0.840
3x 0.088 0.124 0.176 0.249 0.352 0.498
4x 0.062 0.088 0.124 0.175 0.247 0.350
5x 0.048 0.067 0.095 0.134 0.190 0.269
Circles of confusion measure 32 μm (0.032 mm, 32 microns)
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A brilliant red tulip, tipped with early morning mist. The image, with its easily recognizable subject,
deep red color and overlapping petal design meets all the criteria of a worthy composition.

ISO50 | 180mm macro lens | f16 | 1/45s   

George D. Lepp is one of North America’s best-known contemporary
outdoor and nature photographers. His passion for natural beauty,
technical precision, cutting-edge technology and environmental
responsibility are revealed in his beautiful and compelling photographic
images. He is also recognized for his dedication to sharing his
photographic and biological knowledge with other photographers
through his seminars and writing. Kathryn Vincent Lepp is a writer and
editor and former Assistant Dean of the College of Humanities, Arts, and
Social Sciences at the University of California, Riverside. In addition to her
collaboration with her husband,  she often undertakes writing and
editing projects for popular and scholarly publications. Kathryn Lepp
shares her husband’s passion for nature and the natural environment
and also contributes her time to various community causes.

George and Kathryn Lepp 
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Camera Bodies: All of the examples and
techniques presented in this article employ
Digital Single Lens Reflex (DSLR) Canon
cameras. To ensure maximum resolution,
most of them were captured using the
full-frame EOS 5D MK III. In some situations, a
camera with a smaller sensor can offer the
advantage of an additional ‘crop factor’ that
yields higher magnifications. For this reason,
some of the images featured here were
captured with a Canon EOS 7D or 70D; their
APS-C sensors have a 1.6x crop factor. Of

course, full-frame results can also be cropped
to offer higher magnification in the final
image if quality can be maintained. Cameras
that support Live View mode (the ability 
to view the image on the camera’s LCD as 
it is seen by the sensor before capture) are
most efficient for capturing images that 
are to be stacked. Most current DSLRs will
accommodate magnification from close-up
to 8x, but specialty optics and accessories
may be required to achieve greater
magnification.

Lenses: When high-resolution results 
are the goal, quality optics are key. Nearly 
all camera brands and third-party lens
manufacturers offer excellent macro lenses 
in various focal lengths. Because stopping
down the lens to maximize depth of field
compromises clarity due to diffraction of the
light entering the narrow lens opening, a
macro lens that operates well at wider
apertures will achieve better quality. Canon’s
unique MP-E 65mm f/2.8 macro lens is a
favorite for achieving magnifications of 
up to 5x, or 10x when used with a 2x

tele-extender.
An inexpensive way to create a

high-magnification setup is to reverse
mount a normal or wide-angle lens on the
front of a medium telephoto lens. A
male-to-male filter thread adapter will be
necessary for a clean fit, but to test out the
idea, lenses can be mated using heavy-duty
tape. It is best to use single focal length
lenses rather than  zooms for this technique.
The magnification such a combination
provides can be calculated by dividing the
focal length of the telephoto lens attached
to the camera body by the focal length of
the reversed lens. For example, a reversed
50mm lens attached to a 200mm telephoto
will offer a magnification of 4x, while a
28mm reversed wide-angle on a 180mm
telephoto offers a magnification of
approximately 6.4x. One of the lenses must
be left at its widest aperture for this
combination to work, so you will have to test
your particular setup to determine which
configuration gives the best result.

Lighting: Ambient light may be sufficient
at lower magnifications, but at closer working
distances and increased magnifications,

significant light loss occurs. From 1x to
4x, this loss is roughly equal to

(magnification +1) – i.e., you
lose two stops of brightness

at1x, 3 stops at 2x and so
on. For magnifications of
4x and up to 40x and
more, it is most efficient to
rely on TTL metering for

ambient and flash lighting
and to make exposure

decisions depending on the
reflectance of the subject and the

effect you wish to achieve. Guidance is
readily available in the form of the camera’s
LCD display, the image histogram or other

Basic Equipment for Focus Stacking Capture 
from Close-up to 10x Magnification

Macro Workshop | Focus Stacking
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The Canon EOS 5D MK III, the Canon MP-E
65mm 1-5x macro lens and the Canon 
MT-24EX Twin Lite macro flash offer the
ideal combination of resolution,
magnification and lighting both in the field
and in a studio environment



connected displays such as a laptop or iPad. A
bright light source is needed for the subject,
and a focusing lamp may also be necessary to
achieve critical focus through the viewfinder.
Flashes specifically designed for macro work,
such as the Canon MR-14EX Ring Lite and
MT-24EX Twin Lite systems, or the Nikon R1C1
Wireless Close-Up Speedlight are ideal for
imaging beyond 1x magnification because
they offer superb control of the direction and
intensity of the light they produce.

Off-camera LED light sources offer 
several advantages when used for
lower-magnification (close-up) captures in
the studio. They don’t heat up the subject,
their light quality and output is consistent,
the intensity can be adjusted and the effect
on the subject can be viewed in real time.
Such light sources also make effective
focusing lamps. Flash is a better choice 
for work at higher magnifications because of
its greater intensity and short duration,

which can mitigate camera or subject
movement.

Copy Stands: Like a tripod, a copy stand
keeps your gear on a solid footing and allows
quick vertical repositioning of the camera/lens
setup from a viewpoint above the subject. 
The Kaiser Corporation in Germany makes
excellent copy stands. A cheaper alternative is
the RS-CS1070 Heavy Duty Copy Stand from
RPS Studio, which can be purchased through
amazon.com for about US$160. 

While not pretty, this combination of a reversed 
normal lens taped to the front of a telephoto achieves a
magnification equal to the focal length of the rear lens divided
by the focal length of the front lens. In this case, the EOS 70D
with its crop factor of 1.6, the 180mm macro and the 50mm
lens offer a final magnification of 5.8x.

Focus Stacking | Macro Workshop

Several examples of small LED light sources that can be used
to illuminate small subjects in a studio or in the field. The
Neewer CN-160 LED array pictured in the center fits on the
camera’s hot shoe or a stand and is powered by six AA
batteries. The clamps and bendable stalks built into
MightyBright LED book lights make them versatile and ideal
for repurposing as photographic lights.

The Canon EOS 5D MK III coupled 
with the Canon MP-E 65mm macro
lens offers high resolution and
automatic aperture control for easier
focusing. A Canon EF 2x tele-extender
extends the reach to 10x.
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The processes available for capturing stacked
images range from simple to complex, but all
have two objectives in common. First, the
limited depth of field in each capture must
overlap the depth of field in the next image to
avoid small areas of unsharpness in the final
composite. Precision matters: it is possible to
make too few captures, but never too many.
Second, all of the captured images must align
perfectly in the final composite. If the subject
adjusts its position, is blown by the wind, or if
the camera/lens combination moves during or
between captures, the final result will be poor.
While photographing handheld can be
successful in some situations, a tripod or copy
stand is usually necessary to control the proper
register of image slices. Because the intent of

focus stacking is to achieve a highly detailed
result, I suggest you use RAW format for all your
captures.

Focus ring movements: This method
works well using a telephoto macro lens such
as a 100mm, 180mm or 200mm for close-up
subjects that are not too small. Mount the
camera/lens combination on a tripod to
maintain alignment. For nature subjects such
as wildflowers in the field, a tripod that is stable
when positioned low to the ground is essential.
Stop the lens down to f11 or f16 to maximize
the depth of field, then frame the subject and
note the range of depth of field. Without
reframing, make slight movements with the
focusing ring on the lens to move the area of
focus through the subject from front to back.

This enables you to capture an in-focus slice at
each position while ensuring that the depth of
field in each image overlaps that in the prior
and subsequent ones. It is not always desirable
to get every element of the composition
completely sharp. When working with a busy
background, it is a good idea to stop making
fresh captures as soon as the main subject has
been covered.

Handheld movements: This one is tricky
and takes some practice. Set the focus
(magnification) on the lens and frame the
front of the subject. Move the handheld
camera toward the subject in small
increments, capturing the depth of field in
overlapping zones. Quickly take many images
to be sure all areas of the subject are covered;

Capturing Source Images for Stacking

These four captures demonstrate the overlapping zones of focus used to create the tack-sharp image of the
green boa opposite. Close examination reveals the movement of depth of field from the snake’s nostril
through the back of the head to the upper body and finally the lower body. From such a close position, a
single image would not have succeeded in portraying the complex structure of the snake’s head and scales.



moving both forward and backward through
the subject can be helpful. Because it is
impossible to maintain a perfectly consistent
frame while photographing handheld, this
method relies on the post-capture software to
properly align the source images. This
technique only works at lower magnifications
but can be effective when used for stationary
subjects in the field. 

Focusing rail camera movements: At
higher magnification and closer working
distances – i.e., when depth of field is
extremely small – more consistent capture
methods are required. Placing the
camera/lens combination on a focusing rail
allows the photographer to make tiny,
precise movements through the subject. The

best focus rails employ a geared system. It is
essential to use a tripod or copy stand when
you are working with a focus rail, which often
requires you to make a great many captures.
Live View mode allows focus monitoring
enlarged by up to 10x on the camera’s LCD
and guides each movement and capture. For
a larger preview, a live view can be extended
through a USB connection to a laptop
computer running a manufacturer’s utility
program designed to view the monitor
image and control the camera remotely. 

CamRanger internal focus movements:
The CamRanger system wirelessly transmits
the camera’s Live View information via an 
ad hoc wi-fi connection to a tablet or smart
phone from which the photographer can

control a broad range of camera functions
(see www.camranger.com). The device aids
focus stacking by programming the camera
to execute a series of captures at small,
medium, or large incremental changes in
focus. It is necessary to test your setup before
shooting to ensure that you select the best
settings for the lens, aperture and
magnification. The lens must have autofocus
to work with this system; the Canon MP-E
65mm macro lens doesn’t have autofocus
and does not work with the CamRanger, 
but the Canon 100mm and 180mm macro
lenses work well. The enlarged image on a
high-resolution tablet screen is very helpful
in monitoring the focus movements to
ensure that the captures overlap properly.

51c’t Digital Photography 16 (2014)

Focus Stacking | Macro Workshop

This boa’s environment didn’t allow the use of a tripod, so the source images for this stack were captured handheld. Four
overlapped images were captured by physically moving the camera/lens combination through the range of focus. 

ISO200 | 100mm macro lens | f11 | 1/90s



Although it is just three inches in diameter,
this focus-stacked composite of a Beallara
orchid blossom seems enormous compared
to the detail shown on the right. The image
was created using the Focus Stacking setting
in the CamRanger iPad app. Only six captures
were necessary to cover the entire subject.

ISO200 | 100mm macro lens | f8 | 1/8s 



Moving the subject: In some situations it
is easier to move the subject than the
camera/lens combination to capture a
sequence of images for stacking. Macro
subjects will usually be a lot smaller and
lighter than the camera and lens, and can be
placed on a micro stage – the base of a
microscope or other moveable stage capable
of very small and precise positional
adjustments relative to the camera (which is
locked above it on a copy stand). A micro
stage is equipped with measuring gauges that
allow minute, repeatable manual movements
for high-magnification projects. The
movements of the subject toward or away
from the lens are calculated visually and
applied manually based on a live view
transmitted to a laptop computer via USB, or
wirelessly to an iPad using the CamRanger. 

StackShot micro movements: As
mentioned earlier, at higher magnifications
(beginning at about 5x), the image ‘slices’ are
very small and are just 0.095 millimeters thick
at f5.6. The best way to accomplish the
appropriate microscopic movements is to use
the StackShot (www.cognisys-inc.com). This
system is comprised of a focusing rail capable
of movements as small as 2 microns (0.002
millimeters) and a movement controller that
also manages the camera’s rate of capture. The
controller fires at preset intervals to allow the

camera/StackShot to settle between images.
Other fine adjustments that can be made via
the controller include settle time, number of

captures at each position and an auto return
at the end of the stacked series, to name but a
few. The basic procedure is to program the

c’t Digital Photography 16 (2014)

At high magnification, this photograph of the center of a Beallara orchid yields an image of curious design and color. 
The 49 source captures were captured in the studio and controlled wirelessly off-camera using the Focus Stacking setting 
in the CamRanger iPad app. A tele-extender was used to increase magnification to 2x.

ISO200 | 100mm macro lens | f11 | 1.5 s

53

A screenshot of an iPad 3 with the CamRanger wireless off-camera app active



starting point for the image sequence, the
distance the camera should move between
captures and where the last image in the
focusing stack should be taken. Once
activated, the sequence is captured
automatically – the camera is moved very
precisely along the focusing rail using a step
motor and worm gear. The StackShot can be
attached to a copy stand for studio work or
employed in the field with a tripod and an
optional battery system. A longer focusing rail
that allows up to 200 mm of incremental
movements is also available.

When working with the StackShot in the
studio, place the subject on the stage and set
approximate focus before setting up your
flash or LED lighting. Note the magnification
you wish to use, check appropriate charts to
see what the depth of field will be at your
desired f-stop and set the controller to use
increments that are smaller than the resulting
depth of field. Once the system is activated, it
displays the number of captures necessary to
meet the movement and distance criteria and
begins to photograph. A sequence can cover
anything from four or five to several hundred
images and can take from a few minutes to
many hours to complete.

Moving the subject and the camera: Can
things get more complicated? Of course! As
an example, the composite panorama of a
6 x 4mm portion of a luna moth wing shown
below was photographed at very high
magnification and resolution. At 16x, it takes
12 images in three rows and four columns to

cover the entire area. To capture all the detail
in the moth wing, a series of variable-depth
captures was made at multiple focus points
for each of the 12 positions. The final image
is made up of 269 captures and can be

printed to provide stunning high-resolution
detail at up to 60” wide. This kind of project
requires time and concentration; an error in
one of the stacks would render the entire
image useless.
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This beautiful composition was accomplished with 18 focus-stacked captures 
made in the studio. It shows a 10mm section of a Pheobus rurina wing at 3x.

ISO200 | 65mm macro lens | f5.6 | 1/4s
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The ‘eye’ of a Luna Moth wing is presented
in stunning detail when photographed at
16x  and apparently unlimited depth of
field. This image was assembled in Zerene
Stacker software from 12 focus-stacked
composites totaling 269 captures.

ISO 100 | 65mm macro lens / 
EF 2X MK II tele-extender | f5.6 | 1/60s



Successful snowflake photography requires a
snow storm, but not just any snow storm. To
achieve worthwhile results, the snow must be
well formed into separate crystals, and not all
snowfalls offer great subjects. Accomplishing
high-magnification photography in the field
with ambient temperatures at well below
freezing presents an array of logistical
challenges, from creating a portable studio
and powering the StackShot to sheltering the
gear and the photographer from the snow 
and cold.

This continuing project is based on a
small copy stand modified to hold a sturdy
low tripod/ballhead combo from Really Right
Stuff (www.reallyrightstuff.com). The
ballhead points downward and holds the
StackShot with a Canon EOS 5D MK III and
the Canon MP-E 65mm 1-5x macro lens. The
lens has an MT-24EX macro flash attached to
light the snowflakes from above. On the copy
stand, the base of an LED light source works
as a background light. The intensity of the
light can be adjusted and its color changed
by adding filters to create an interesting
background. A small, clear plastic cylinder

placed on the LED base supports a glass slide
which acts as the stage on which the
snowflake is photographed. This positioning
blurs the background and creates a space
where additional colored light sources can
be placed at 45-degree angles to give some
definition to the clear crystal. The additional
lights can be flashes with colored filters
attached or small LED lights covered with
colored gels.

The falling snowflakes are captured on a
black card and those with promising
structures are quickly moved onto the glass
slide using a tiny paintbrush. With the
CamRanger attached to the camera and
transmitting image and camera data
wirelessly to an iPad3, the snowflake can be
viewed at high magnification. Nine images are
usually sufficient to cover a fairly flat
snowflake at magnifications of around 5x. If
greater magnifications are required, adding
an EF 2x extender increases the magnification
to a maximum of 10x. Alternatively, using a
camera body with a crop factor of 1.5 or 1.6
will achieve 7x or 8x magnification without 
an extender. 

High Magnification Stacking in the Field 
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This snowflake, photographed at 8x on an
exceptionally cold day in the Colorado
Rockies, displays finely formed and delicate
crystals portrayed using eight focus-stacked
captures and subtle colored lighting

ISO100 | 65mm 1-5x macro lens and 1.6 crop
factor sensor | f5.6 | 1/15s

Capturing snowflakes at magnifications of up to
5x requires a complex set of equipment that can
be mobilized according to Mother Nature’s whims: 

1. This setup is built on a copy stand base with a
Really Right Stuff TP-243 Ground-Level tripod
and BH-55 ball head 

2. Canon EOS 5D MK III with Canon MP-E 65mm
macro (1-5x) lens 

3. Canon MT-24EX TwinLite macro flash 
4. StackShot rail 
5. StackShot controller 
6. Snowflake subject on a glass slide mounted on a

clear plastic cylinder 
7. LED base light array with blue acetate gel 

positioned beneath the subject 
8. Four LED lights with colored gels positioned to

illuminate the subject from below
9. CamRanger attached to the camera via USB

cable 
10. iPad3, encased in a Lifeproof waterproof 

enclosure and running the CamRanger app.
10.

4.

3.

9.

2.

6.

7.

8.

5.

1.
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If you want to get even closer to your subject,
you can use microscope objectives and
tele-extenders to achieve magnifications of
up to 64x. Used with a full-frame camera, the
Canon MP-E 65mm macro lens and the EF 2x

tele-extender can capture magnifications of
up to 10x. To photograph butterfly scales at
higher magnification, you can use Nikon
microscope optics called CF Infinity Corrected
Objectives. To be effective, objectives need to
be mounted on a host lens with a focal length
of approximately 200 mm. This kind of setup
is called a “tube lens” in microscopy circles.
The Nikon objectives screw into the front of
the host lens using a special adapter.

Two examples of these lens/objective
combinations are used in this article. The
Nikon CFI BE Plan 10x/0.25 (approximately

US$100 and readily available on the Internet)
produces 10x magnification with the Canon
180mm macro on a full-frame camera, and
can attain 20x by adding a Canon EF 2x

tele-extender. 
The Nikon CF Plan 20x/0.40 (available used

for US$500 or more) achieves 20x

magnification with a 200mm host lens (at its
widest aperture) on a full-frame camera, and

40x with an added EF 2x extender. However,
to prevent vignetting, it is best to use 
these combinations with an APS-C camera. 
A smaller sensor adds to the magnification in
the form of a crop factor of 1.5 for Nikon
cameras and 1.6 for Canon cameras. Note that
the depth of field in the resulting images will
be minimal and the use of a step rail is
essential for this type of work.

Capturing Focus Stacked Images 
at Extremely High Magnifications

Successful focus stacking begins with the
capture of a series of sharp images of
adjoining and overlapping slices through a
subject, and ends by assembling the slices to
produce a single image with controlled and
expanded depth of field. The compositing
software works by retaining sharp elements of
each capture and discarding anything that is
out of focus. Several focus stacking programs
exist, and we will take a look at three of the
most popular here: Adobe Photoshop, Helicon
Focus and Zerene Stacker. Each program has its
own particular strengths, and all three are
available for a 30-day free trial.

A little preparation and organization will
improve the outcome of any focus stacking

session. A workflow is always a personal thing,
but a good sample procedure is as follows: 

1. Import your RAW source images into
Lightroom 5 (earlier versions also work) and
check the images at the beginning and end of
the sequence to determine if any can be
eliminated. If the sequence begins or ends
beyond the actual subject there may be
several images that have no sharp areas
whatsoever. These can be discarded.

2. Highlight all the images in the stack
and select one that well represents the
overall exposure, color and tone in the
subject. Open this image in the Develop
module, optimize it for sharpness, contrast,
saturation and clarity, then click the ‘Sync’

button at the bottom right-hand corner of
the program window. This duplicates the
corrections you have made to the
representative image for the entire set. 

3. Some programs do not support
proprietary RAW formats, so convert your
images to 16-bit TIFF during export to a
separate folder. As an alternative, you 
can also consider the Lightroom plug-ins
available for Helicon Focus and Zerene
Stacker, as these preserve changes made in
Lightroom while converting images to TIFF
format for assembly.

The source captures are now ready to 
be assembled into a single focus-stacked
image. (sea)

Assembling a Focus Stacked Image

A tiny (< 1mm) section of the wing of a Phoebis rurina photographed at 
64x reveals amazing texture and brilliant color. Twelve focus-stacked 
captures provided the necessary depth of field.

ISO200 | 180mm macro lens, EF 2x MK II extender, Nikon CF Plan 20x/0.40 objective | f6.7 | 1/60s

Nikon microscope objectives can be mounted
on a host lens using an adaptor with an RMS
thread. They enable full-frame captures of up
to 40x or 64x using an APS-C camera.



Compositing in Photoshop (CS4-CC)  

If you are already familiar with Photoshop, it is a relatively simple matter to use the
program’s onboard tools to create focus-stacked images. Photoshop aligns and
composites images in two separate actions, whereas Helicon Focus and Zerene Stacker
align and assemble in a single combined process. Of the three programs mentioned
here, Photoshop appears to be the least precise and sometimes includes small areas of
unsharpness in the final rendering.

1⎢Import your source captures into Photoshop (CS4 or
later) by highlighting them in Bridge and clicking on
Tools > Photoshop > Load Files Into Photoshop Layers.

2⎢Highlight all the imported layers and select the Edit >
Auto Align Layers command. In the dialog that then 
appears, leave the Projection set to Auto and click OK.
All the layers will then be aligned.

4⎢Crop off the out-of-focus edges to finish the image

3⎢With all the layers still highlighted navigate to the 
Edit > Auto-Blend Layers command and select the Stack
Images option in the dialog that follows. Check the 
Seamless Tones and Colors option and click OK. The
image will now be rendered.
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5⎢To flatten the layers and save the image, click on the
pull-down menu in the top right-hand corner of the
Layers panel and select the Flatten Image command.
The flattened image can now be saved using the 
commands in the File menu.
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Helicon Focus

Helicon Focus was a groundbreaking pioneer in the field of focus stacking and continues
to improve and incorporate new functions. Over and above the basic rendering
procedure described here, the software offers many additional options that can improve
stacked output. Helicon Focus can process RAW source files but converts them
automatically to TIFF during processing. Previous edits are not preserved.

1⎢Open the program and click Add Images (at
top left). Navigate to your source folder and
highlight the images you wish to stack.

2⎢The selected images will display in a column
on the right-hand side of the screen. Click the
‘Focus’ button, then click on the green 
‘Render’ button.

5⎢Save the finished image under 
File > Save

3⎢The program will then run through the image
set and present a sharp composite image
when it is done. Choose the View option at
the top left of the screen to display each 
capture as it is being rendered. It is 
fascinating to observe the real-time growth
of the area of sharp focus as it expands
through the newly created image.

4⎢Use the retouching feature to correct any
problem areas. If a spot on the composite is
out of focus but is sharp in one of the other
source captures, the sharp area can be cloned
and inserted into the composited image. This
powerful feature is not available as part of
Photoshop’s focus stacking tools, but Zerene
Stacker does have similar functionality.
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Zerene Stacker

Based on hundreds of trials, Zerene Stacker consistently produces the best
results for complex focus-stacking tasks. The program also offers excellent
built-in tutorials for the capture and assembly of focus-stacked images. 

1⎢Launch the program and navigate to
your source folder. Highlight the 
converted 16-bit TIFF files and drag
them into the column on the left of the
Zerene Stacker window.

2⎢Click anywhere in the column to 
activate the menu at the top of the
screen. Click Stack > Align & Stack All.
The program will begin the
compositing process, displaying the
image currently being incorporated on
the left and the composite image being
created on the right. The experience is a
lot like watching a black and white print
appear in the developer tray.

3⎢If touch-up is needed for an area that
was good in the original slice but got
lost in the final compilation, go to 
Edit > Start Retouching. Clone the 
appropriate pixels from the individual
capture on the left to the composited
image on the right. Once you are done
making corrections, click Edit > Commit
Retouching.

4⎢To save the composited image go to
File > Save Output Image(s). Designate
a save folder and click Save, then click
OK. The final window confirms the
destination of the saved file. Click OK
to finish up. 

c



Macro Lens Test | Original vs. Third-party

Thomas Hoffmann, Sophia Sieber

Macro Lens Test
Manufacturers’ Own vs. Third-party Glass

All the major DSLR manufacturers include 90mm, 100mm or 105mm
macro lenses in their ranges and photographers often choose to use
these own-brand optics as a matter of course. However, third-party lens
manufacturers such as Sigma, Tamron and Tokina offer cheaper
alternatives, while Zeiss offers its own more expensive lenses for the
macro sector. We tested whether original or after-market macro lenses
are the better option – read on to find out what we discovered.
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Macro photography requires patience
but can be extremely relaxing. If you

take the time to concentrate fully on
composition, camera settings and the subject
itself, the resulting view into microscopically
tiny worlds is highly rewarding. If you 
take macro photography seriously, at some
point you are sure to want to purchase a
purpose-built macro lens. 

SLR users have a wide choice of specialized
lenses with focal lengths that vary from
wide-angle to medium telephoto. This test
covers a selection of lenses in the popular
90-105 mm range.

All-round Lenses for 
Macro Beginners
General purpose macro lenses are relatively
light and compact and give macro
photography beginnners plenty of scope for
experimentation, with close focus distances
of around 30 cm (12 inches). Standard-length
(50-60 mm) macro lenses tend to have

slightly shorter close-focus distances of
around 20 cm. 

A greater close-focus distance helps 
to maximize the light yield in macro 
shots and reduces the risk of the lens itself
casting shadows on the subject. Greater
subject-to-lens distances also give you more
scope for using additional lighting. Medium
telephoto macro lenses are less prone 
to unwanted camera shake than their 
telephoto counterparts and can often be 
used successfully handheld. As a bonus, these
types of lenses also double as great portrait
lenses in non-macro situations, enabling you
to shoot well-defined subjects with soft
background bokeh. 

We took a close look at the 100/105mm
lenses from Canon, Nikon and Sony and
compared them with the third-party
competition from Sigma, Tokina, Tamron and
Zeiss. Full-frame lenses from the major
manufacturers share their bayonets with their
APS-C cousins, so there is nothing to stop you
from using them with APS-C cameras too.

There are many more specialty macro lenses
available for full-frame cameras than there are
for APS-C models. 

Save Money with 
Third-party Glass
Sigma, Tamron and Tokina all have
reputations for producing great lenses at
competitive prices. For example, the current
street price for the Sigma 105mm f/2.8 EX DG
OS HSM is around US$670, compared with the
equivalent AF-S VR Micro-Nikkor 105mm
f/2.8G IF-ED for about US$900. In the Canon
camp, the EF 100mm f/2.8L Macro IS USM also
costs around US$900 new, compared with the
Tokina 100mm f/2.8 AT-X Pro D that, at
US$400, costs less than half as much. 

Compared to all these models, the Zeiss
Makro-Planar T* 100mm f/2 (we tested the ZF
version) at around US$1850 definitely
represents a serous system upgrade rather
than just an additional lens purchase. The
Zeiss maximum aperture of f2.0 is the widest
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We visited the Berggarten orchid greenhouse in Hannover to capture our real-world 
test shots. In this ‘group portrait’, the lenses fit in well with their temporary surroundings. 



of all our test lenses, although its reproduction
ratio maxes out at 1:2. 

Although we focused mainly on the DSLR
world, we also took a look at the mirrorless
alternatives. There are currently only two
purpose-built macro lenses available for the
Micro Four Thirds system, but these
lightweight contenders are certainly an
attractive option if you spend a lot of time on
the road and want to minimize the weight of
the gear you carry. 

Tests in the Lab and in the Field

To provide a balanced set of results from
sensors with similar (22- and 24-megapixel)
resoutions, we mounted our test lenses on
full-frame Canon 5D Mark III, Nikon 610D and
Sony SLT-A99 bodies for our lab tests. 

To test overall resolution, we shot a
frame-filling aperture bracketing sequence
of a test chart comprising 25 Siemens stars
with sine wave-shaped brightness gradients.
We focused manually for all our lab-based
shots. We then analyzed the range of
contrast between the brightest and darkest
part of each shot using custom software, and
averaged the cut-off frequency (i.e., the
number of resolved line pairs) in a number of
directions for each star. 

We measured distortion using a special chart
made up of repeated printer’s register marks
and determine the degree of distortion by
analyzing the offset between the measured
position of a specific point within the image and
its theoretical position under ideal conditions.

We also shot an aperture bracketing sequence
of real-world test shots in the Berggarten
orchid greenhouse in Hannover.

Last but not least, we measured the degree
of vignetting using an integrating sphere (see

en.wikipedia.org/wiki/Integrating_sphere for
more details).  

Our test subject was a dendrobium orchid
that was just large enough to produce
frame-filling results.
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Macro photos can be just as effective
when captured with smaller sensors
like the Micor Four Thirds model
built into the Olympus OM-D shown
here. Smaller sensors also provide
greater magnification (see page 74
for more details).

The 25 Siemens stars
that make up our test
scene enabled us to
precisely judge the
quality and resolution
of the test lenses
right into the corners
of the frame



100mm | ISO100 | f11 | 0.6 s
Below: The top left-hand corner of the c’t lab test scene at ISO 100 Below: Chart detail (see page 63)

Canon EF 100mm f/2.8L IS USM
The Lens: This model belongs to the pro-grade ‘L’ series of lenses.
Weighing in at 625 g (1.38 lb), it has a high-quality heft and is also dust
and moisture resistant. It focuses internally, so its length doesn’t change
during focus adjustments. The focusing ring is grippy and well balanced,
and has just the right amount of play, making manual focusing simple and
precise. 

Test results and image quality: The EF 100mm delivered relatively
consistent results throughout the frame, although resolution drop-off at
the edges measured as much as 10 percent at maximum aperture. The
lens produces its best results at f5.6, recording 90 percent of the potential
maximum resolution provided by the EOS 5D Mark III’s sensor. At f11,
there is no longer any detectable difference between center and edge
resolution. Overall performance begins to fall off at f16 and below and
ended up recording just 1064 line pairs of resolution at minimum
aperture.

Shooting wide open, our real-world test shots show pleasant bokeh
with consistent circles of confusion. We particularly liked the Canon’s
detail contrast, which is obvious in our test shots (see below and the
archive provided on this issue’s free DVD). This lens produces great
definition in even the finest textures and only produces obvious
vignetting at maximum aperture. Distortion was negligible across the
board and we found no obvious chromatic aberrations at all.

f2.8 f5.6f32f11f2.8

Canon EF 100mm f/2.8L IS USM
Length 123 mm (4.84 inches)
Focal length 100 mm
Max. reproduction ratio 1:1
Aperture range / # of blades f2.8-f32 / 9
Closest focus 30 cm (12 inches)
Current street price US$1,050
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1585/ 1671/ 1064
Edge resolution1 1360/ 1557/ 1035
Vignetting2 1.4/ 0.2/ 0.2
Distortion (at f8) 0 %
1 In line pairs 2 In f-stops
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100mm | ISO100 | f11 | 0.6 s
Below: The top left-hand corner of the c’t lab test scene at ISO 100

Tokina 100mm f/2.8 AT-X M100 AF Pro D 
The lens: We tested the Tokina with our Canon EOS 5D Mark III. Focused
at infinity, it is quite a bit shorter than the Canon lens and also slightly
lighter. The Tokina, however, does not focus internally like the Canon
and is thus longer when focused on a close object. Build quality is good,
although the focusing ring is slightly looser in use than the Canon’s.
Instead of using a dedicated switch, the Tokina design means that you
have to shift the entire focusing ring backward to switch to manual focus
mode, which makes it impossible to intervene in autofocus mode
without producing unwanted camera shake. Overall, the Canon lens has
a higher-quality look and feel. 

Test results and image quality: In terms of image quality, the Tokina
keeps pace well with the Canon lens. In the lab, it measured 1665 line pairs
of resolution wide open – a value that is as good as or better than the
direct competition. We noticed slight resolution drop-off toward the
edges of the frame and recorded a value of 1712 line pairs at f5.6, which
is the same as that produced by the Canon lens and represents almost 90
percent of the maximum potential resolution of the EOS 5D 
Mark III’s sensor. Vignetting was minimal wide open and the lens
produced no detectable distortion. On the downside, most of our test
images contain visible chromatic aberrations.

Our real-world test images are all extremely sharp but show
inconsistent, often elliptical circles of confusion. 

f2.8 f5.6f32f11f2.8

Tokina  100mm f/2.8 AT-X M100 AF Pro D 
Length: standard/extended 95/140 mm (3.74/5.51 inches) 
Focal length 100 mm
Max. reproduction ratio 1:1
Aperture range / # of blades f2.8-f32 / 9
Closest focus 30 cm (11.8 inches)
Current street price US$400
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1665/ 1693/ 999
Edge resolution1 1425/ 1550/ 994 
Vignetting2 0.9/ 0.2/ 0.2
Distortion (at f8) 0 %
1 In line pairs 2 In f-stops

Individual Tests | Macro Lens Test

Below: Chart detail (see page 63)



66 c’t Digital Photography 16 (2014)

Macro Lens Test | Individual Tests

100mm | ISO100 | f11 | 1/4s
Below: The top left-hand corner of the c’t lab test scene at ISO 100 Below: Chart detail (see page 63)

Zeiss Makro-Planar T* 100mm f/2
The lens: The Makro-Planar is the most expensive lens in our test and our
expectations were correspondingly high. When a lens with no autofocus,
no image stabilizer, no internal focusing and no moisture resistance costs
from twice to more than four times as much as the competition, we
simply have to assume that its image quality is unparalleled. Physically,
the Zeiss delivers on all fronts.The all-metal body is pleasantly heavy, the
included sunshade is lined with a soft, velvet-like material and the
markings on the lens body are engraved rather than just printed like
those of the competition. The focusing ring offers a pleasant degree of
resistance and its 360-degree rotation range makes it possible to focus
extremely precisely. The only real limitation is the relatively small
maximum reproduction ratio of 1:2.

Test Results and image quality: This lens is the best option available
for photographers who want to squeeze the very last drop of sharpness
out of their subjects. The excellent overall image quality is accompanied
by typical high-quality Zeiss detail and color renditiion, and we recorded
our best results between f4 and f5.6. In other words, this is a great 
all-round macro lens. Vignetting of only 0.7 stops at f2 (the brightest
maximum aperture in our test) is perfectly acceptable and the effect
disappears completely at smaller apertures for this and most of the
other test lenses. Distortion and chromatic aberration are negligible or
simply non-existent at all apertures.

Our real-world test images matched the expectations produced by our
lab results, showing high detail contrast and vividly authentic color
reproduction.

f2.8 f5.6f22f11f2.8

Zeiss Makro-Planar T* 100mm f/2
Length: standard/extended 113/115 mm (4.45/4.52 inches)
Focal length 100 mm
Max. reproduction ratio 1:2
Aperture range / # of blades f2-f22 / 9
Closest focus 43 cm (16.93 inches)
Current street price US$1,850
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1663/ 1672/ 1250
Edge resolution1 1507/ 1643/ 1217
Vignetting2 0.7/ 0.1/ 0.1
Distortion (at f8) 0 %
1 In line pairs 2 In f-stops



Shot with the Canon EOS 5D Mark III and
the Zeiss Makro-Planar T* 100mm f/2 
ISO100 | f2.8 | 1/60s
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90mm | ISO100 | f11 | 1/10s
Below: The top left-hand corner of the c’t lab test scene at ISO 100 Below: Chart detail (see page 63)

Tamron SP 90mm f/2.8 Di VC USD 1:1 Macro
The lens: In spite of having the shortest focal length in our test field, the
Tamron requires you to use only 1 cm less subject-to-lens distance than
the Nikon lens in order to produce an image with a reproduction ratio of
1:1. Like the Micro-Nikkor, the Tamron focuses internally but is smaller and
lighter, making it less of a burden on photo excursions. The lens is
moisture resistant, making it ideal for outdoor use in poor weather. In
addition, the short telephoto focal length, the built-in image stabilizer and
the fast (and virtually silent) ultrasonic focus motor make this a great lens
for capturing spontaneous portrait shots too. The focusing ring has
virtually no play and focuses precisely. The use of plastic components give
the Tamron a lower-quality feel than the Zeiss and Nikon offerings, but it
is nevertheless a solid performer.

Test results and image quality: The Tamron delivered almost 1,700 line
pairs of resolution between f8 and f11 and continued to perform well all
the way down to f16. Quality dropped off quickly beyond f16, delivering
only 70 percent of potential maximum resolution (i.e., around 1,000 line
pairs at minimum aperture). Center and edge resolution are equally good
throughout the aperture range, while vignetting came in at a respectable
0.6 stops wide open and 0.1 stops stopped down. 

Our lab test shots confirmed these values. At f8, the lens offers finely
detailed reproduction and no visible lens errors. There is some visible
highlight fringing wide open and, as with the Micro-Nikkor, your choice
of focus points limits the range of apertures you can select.

f2.8 f5.6f32f11f2.8

Tamron SP 90mm f/2.8 Di VC USD 1:1 Macro
Length 115 mm (4.5 inches)
Focal length 90 mm
Max. reproduction ratio 1:1
Aperture range / # of blades f/2.8 – f/32 / 9
Closest focus 30 cm (11.8 inches)
Current street price US$750
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1564/ 1683/ 1013
Edge resolution1 1508/ 1602/ 988
Vignetting2 0.6/ 0.1/ 0.1
Distortion (at f8) 0 %
1 In line pairs 2 In f-stops



Captured with the Nikon D610 
and the Tamron SP 90mm f/2.8
ISO100 | f16 | 1/2s



105mm | ISO100 | f11 | 1/2s
Below: The top left-hand corner of the c’t lab test scene at ISO 100 Below: Chart detail (see page 63)

Sigma 105mm f/2.8 EX DG OS HSM
The lens: This is obviously not a value lens. Its three dedicated switches
(image stabilizer, focus mode and focal distance limiter) give it a
high-quality, professional look, and the lens even comes complete with
two sunshades for use with full-frame and APS-C sensors. Like the Canon
and Nikon models, the Sigma focuses internally using a small number of
lens elements and therefore has a fixed length. Unlike the Sony lens (see
page 72), the Sigma’s autofocus mechanism is virtually silent. 

Test results and image quality: The Sigma’s center resolution is not quite
as good as that of the Sony at maximum aperture, recording 1,571 line
pairs compared with the Sony’s 1,630 (from a theoretical maximum of
2,000). However, at f8, this relationship reverses, and the the 1660 and
1592 line pairs recorded by the Sigma in the center and at the edges of
the frame are both better numbers than those from the Sony. After all, it
is stopped down resolution that is often crucial in macro situations. As
with most of the other test lenses, the Sigma produces no distortion to
speak of and there was no visible chromatic aberration either. Vignetting
came in at an acceptable 1.2 stops wide open and disappeared almost
completely stopped down.

Our real-world test shots show good sharpness and vivid colors and a
little more sharpness than the ones we captured using the Sony lens. The
circles of confusion are slightly angular but the overall bokeh effect is
nevertheless pleasantly balanced.  

Sigma 105mm f/2.8 EX DG OS HSM
Length 126 mm (4.96 inches)
Focal length 105 mm
Max. reproduction ratio 1:1
Aperture range / # of blades f2.8-f22 / 9
Closest focus 31 cm (12.3 inches)
Current street price US$670
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1571/ 1661/ 1415
Edge resolution1 1500/ 1495/ 1387 
Vignetting2 1.2/ 0.1/ 0.1
Distortion (at f8) -0.1 %
1 In line pairs 2 In f-stops
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Photographed with the Sony Alpha 99
and the Sigma 105mm f/2.8 
ISO100 | f5.6 | 1 s
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100mm | ISO100 | f11 | 1/3s
Below: The top left-hand corner of the c’t lab test scene at ISO 100 Below: Chart detail (see page 63)

Sony 100mm f/2.8 Alpha A-Mount 
The lens: The Sony macro is one of the lighter and less
spectacular-looking lenses in our test field, but what it lacks in looks, it
makes up for with its sound! Autofocus is accompanied by loud creaks
and  squeaks while the motor shifts the focusing elements – behavior that
is less than optimal when it comes to photographing small, shy creatures
from close up. This situation is compounded by the fact that you can only
switch between auto and manual focus via the camera menus. On the
plus side, build quality is good, although it is not up to the standard of the
Zeiss or the Canon. Once you have switched to manual focus mode, the
focusing ring offers a useful level of friction that enables smooth, precise
focusing. 

Test results and image quality: Although it didn’t produce the best
results in our test, the Sony lens performed consistently throughout the
aperture range. Wide open, it utilized 80 per cent of the A99 sensor’s
potential resolution in the center of the frame and about 75 per cent at
the edges – a difference that is all but undetectable under most
circumstances. Edge resolution is slightly better at f8 but overall image
quality drops off again at f11 and beyond, reaching a critical value of less
than 1,000 line pairs stopped all the way down. 

Compared for example with the Canon, the Sony lacks overall
sharpness (see the chart details below and the sample images on this
issue’s Free DVD to compare them for yourself). As with most of the lenses
tested here, the Sony produces virtually no visible chromatic aberration
and distortion. 

f2.8 f5.6f32f11f2.8

Sony 100mm f/2.8 Alpha A-Mount
Length: standard/extended 95/140 mm (3.74/5.51 inches)
Focal length 100 mm
Max. reproduction ratio 1:1
Aperture range / # of blades f2.8-f32 / 9
Closest focus 36.6 cm (14.4 inches)
Current street price US$750
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1630/ 1627/ 987
Edge resolution1 1502/ 1541/ 951 
Vignetting2 0.9/ 0.1/ 0.1
Distortion (at f8) 0.1 %
1 In line pairs 2 In f-stops



73c’t Digital Photography 16 (2014)

105mm | ISO100 | f11 | 1/13s

Below: The top left-hand corner of the c’t lab test scene at ISO 100 Below: Chart detail (see page 63)

AF-S VR Micro-Nikkor 105mm f/2.8G IF-ED
The lens: The internal focusing mechanism, bright maximum aperture
and moisture resistant body make this a big lens. Its all-metal construction
weighs in at 750 g (26.5 oz). The ultrasonic autofocus motor is virtually
silent and, thanks to the internal focus mechanism, the overall length of
the lens remains the same at all times. Autofocus is fast enough for
snapshots too, especially if you use the focus limit feature to exclude
close-up distances from the range. The built-in image stabilizer also gives
you up to three stops of extra exposure leeway and enables you to shoot
handheld in low light or other tricky situations. The focusing ring has
sufficient range to make manual focusing smooth and precise.

Test results and image quality: Our resolution measurements produced
disappointing results, and the lens only achieved more than 70 percent
resolution between f8 and f16. At these apertures, there was no
detectable difference between edge and center resolution. A vignetting
value of just 0.9 at f2.8 is, on the other hand, excellent and the effect
disappears completely at smaller apertures. The distortion produced by
the lens was measurable but nevertheless negligible in its effect.

Stopped down, the Micro-Nikkor produced highly three-dimensional
images with no evidence of fringing at critical edges. The weak
maximum-aperture resolution we measured in the lab is also visible in
our real-world sample images, but things look much better as soon as
the lens is used stopped down. Unusually, the aperture range varies
according to magnification – for example, at 1:1, the maximum available
aperture is f4.8.

f2.8 f5.6f32f11f2.8

AF-S VR Micro-Nikkor 105mm f/2.8G IF-ED

Individual Tests | Macro Lens Test

Length 116 mm (4.6 inches)
Focal length 105 mm
Max. reproduction ratio 1:1
Aperture range / # of blades f2.8-f32 / 9
Closest focus 31 cm (12.2 inches)
Current street price US$900
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1261/ 1426/ 1062
Edge resolution1 1354/ 1573/ 1028
Vignetting2 0.9/ 0.1/ 0
Distortion (at f8) -0.1 %
1 In line pairs 2 In f-stops
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A 1 Euro Cent coin fills
more of a Micro Four

Thirds sensor at 1:1
than it does with a 

full-frame sensor. You
can achieve the same

absolute proportions by
reducing Micro Four

Thirds magnification.

Compared with its full-frame cousins, the moisture resistant
M.ZUIKO ED DIGITAL 60mm f/2.8 Macro lens looks almost like a
toy, although its price is still thoroughly grown-up! Overall build
quality is good and a prominent switch on the lens body is used to
switch between focus ranges. 

Micro Four Thirds sensors have a crop factor of 2, making the
angle of view of the 60mm Olympus lens equivalent to that of a
120mm full-frame lens. The 1:1 close focus distance of 19cm is
about the same as that of a 60mm full-frame macro lens. 

Considerations When Using 
a Crop-format Macro Lens
1. If, for example, you wish to use a crop-sensor camera to capture
a butterfly that fills the 36 x 24mm full-frame sensor at a
magnification of 1:1, you will have to reduce the magnification by
increasing the camera-to-subject distance if you want to avoid
cropping the subject. 

2. The full-frame lenses described in our main test all have close
focus distances of about 30 cm for 1:1 magnification. The close
focus distance for the Micro Four Thirds lens is 10 cm shorter and
could make it more difficult to work comfortably with small
subjects.

Test Results and 
Image Quality
Judged by its lab results, the Olympus lens is a worthy competitor
for the full-frame lenses we tested. The results are not spectacular

but are extremely consistent throughout the aperture range 
and across the entire frame. It produced its best center 
and edge resolution at f4 but only managed to record 840 line
pairs when stopped all the way down. Distortion and
vignetting were negligible and the mechanics allowed 
precise manual focusing, even if the resulting images 
weren’t quite as detailed and contrasty as those we captured
using our full-frame lenses.

M.ZUIKO DIGITAL ED 60mm f/2.8 Macro

Micro Four Thirds Macro Lenses

f5.6 f4

Mirrorless system cameras can be used in macro situations
too. From the various sensor formats available today, we
picked Micro Four Thirds as an example and performed a
quick standalone test on a single lens. Thanks to the small
sensor format and the narrow bayonet diameter, such
specialist lenses turn out really compact. 

Length 82 mm (3.23 inches)
Focal length 60 mm (120 mm equivalent)
Max. reproduction ratio 1:1
Aperture range / # of blades f2.8-f22 / 7
Closest focus 19 cm (7.4 inches)
Current street price US$400
Test Results Wide open / f8 / Minimum aperture
Center resolution1 1602/ 1650/ 852
Edge resolution1 1503/ 1501/ 837 
Vignetting2 0.6/ 0.1/ 0.1
Distortion (at f8) 0 %
11 In line pairs 2 In f-stops 



Conclusions 
Our test results demonstrate clearly that
brand-name gear is not the only option.
Models from the likes of Sigma, Tamron and
Tokina save you a lot of money but still provide
more than adequate build quality and feature
sets. Dust and water resistance, internal
focusing and image stabilizers are now
standard features in many third-party lenses.

One of the obvious drawbacks of less
expensive lenses is the quality of the materials
used and the handling that results. The Sigma
lens we tested was a welcome exception, but
the other third-party optics don’t generally
have the heft or quality feel of the Nikon and
Canon competition. The results nevertheless
speak for themselves, with Tokina beating the
Canon on most fronts and the Tamron leaving
the Nikon standing in several respects.

The Canon’s high-end ultrasonic motor
and internal focusing functionality are nice
to have but don’t play a direct role in
producing successful macro photos. The
Sony too, has its own particular quirks, and
extends to almost double its original length
when used to capture subjects at 1:1. The
level of noise its autofocus motor produced

gave us cause to worry about the integrity of
its mechanics.

The Sigma and the Tamron were the best
all-rounders in our test. In spite of their
relatively long focal lengths, their ultrasonic
motors and image stabilizers make them
great for handheld and/or portrait shooting.
Both these models also have smooth and
precise manual focusing capabilities.

The Zeiss is something of an anomaly,
providing only 1:2 magnification for twice the
cost of the Canon and Nikon equivalents. The
major plus offered by the Zeiss is, of course, its
excellent reproduction quality throughout the
aperture range. It also scores highly with its
wide-aperture sharpness, offering image
quality that others only begin to approach
when used stopped down. It performs best at
around f8, which is still fairly wide for many
macro applications. 

In spite of its lack of an image stabilizer,
autofocus and internal focusing, the Zeiss also
sets standards with respect to overall build
quality. It is a joy to focus manually using its
bright maximum aperture and wonderfully
smooth focusing ring.

The major drawback common to all the
lenses we tested is their full-frame geometry,
which makes them quite large and heavy. An
additional 800 g (28 oz) of glass and metal
won’t make a big difference if you are
concentrating on macro work using a tripod
or focusing  rail, but things look different if you
want to use one of these lenses on a walking
tour. Crop-format lenses keep your kit light
and compact and also offer greater depth of
field at similar magnifications. Their image
quality is only poorer at high ISO settings.

We are spoiled for choice in today’s
market. The image quality offered by the our
test lenses was surprisingly good in view of
the price differentials involved and it is only
the build quality that differs obviously
between the manufacturers’-own and
after-market models. 

If you are looking to purchase a macro lens,
we can wholeheartedly recommend taking
the third-party route. However, if absolute
precision and ultimate image quality in a
variety of situations is your goal (and money
is no object), the Zeiss solution is the only 
real option. (ssi, tho)  c
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Michael Jordan

Natural

Light
Sunlight is the most widely used photographic light
source. Anyone who has a feel for the way light behaves
can learn to utilize its characteristics in many different
ways. This article looks at how to use natural light to
shoot effective photos in a variety of situations.



Creating photographs is all about
‘painting with light’. Light is essential to

the process of photography – without it, an
image cannot exist. If you look at a bunch of
photos, you will quickly realize that each
depicts a situation with its own unique
lighting. Compare shots of the same scene –
a landscape, for instance – photographed at

different times of day, in different weather or
in summer instead of winter, and you will see
how crucial variations in the prevailing light
are to the mood of each image.

Sunlight, delivered either directly from a
clear sky or indirectly through clouds or mist
is the most widely used source of light in
photography. This article is about what light

is and how best to use it to create great
photographs.

To begin with, we will take a look at light
itself – what it is made of, how it behaves and
the characteristics luminance, direction, color
and quality. Once you have developed a feel
for light, you will soon learn to use it to 
give your subjects meaning and transport a
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This image tells a story and stirs the viewer’s emotions. For extreme close-ups like this, it is 
simpler to focus manually and fine-tune focus by moving the camera back and forth.

Full-frame DSLR | 50mm lens with extension tubes | 1/200s | f16 | ISO200



message. We will then look at specific
situations and types of images and investigate
how to make the most of the available light.

Like an electric lamp or a flashlight,
daylight is a continuous light source that
provides consistent-looking light over a
period of time. Just how long it remains
consistent depends on the weather and, of
course, the clouds. In continuous light, a
longer exposure produces a brighter image.
Unlike daylight, flash lights up a scene for a
very brief moment, so increasing the exposure
time for a flash shot will not produce a
brighter image. Imagine shooting with flash
in a completely dark room, and you will see
why this is the case.

Luminance

In a photographic context, the most
important aspect of light is its luminance, or
the ‘amount’ of available light. If there is
enough light available, it can be used to
create a photo. The three basic parameters
that regulate a photographic exposure are
aperture, exposure time and ISO sensitivity.

The range of available settings depends on
the limits of your camera‘s technology – for
example, its maximum ISO setting and the
capabilities of your lens. The maximum
aperture and the presence (or lack) of an
image stabilizer will play a role in the types
of image you can successfully capture. At
extreme telephoto and macro focal lengths,
you also run the risk of capturing unwanted
camera shake. 

The issue of getting exposure right is the
same, whether you shoot in manual exposure
mode or using one of your camera’s auto,
programmed or creative modes. Whichever
mode you use, the built-in light meter will
show the correct exposure parameters based
either on ithe camera’s own values or the
settings you have made. You can then use 
the correct exposure parameters to capture 
what you see and store it as a memento or
document of a particular event or object. 

Usually, however, we want more than just
a matter-of-fact record of our experiences.
Most photographers want to produce images
that touch the viewer’s emotions. To do that,
you need more than just an attractive subject

or an interesting viewpoint. What you need is
the right light. 

Using Histograms

The histogram, which graphs the distribution
of tonal values throughout the frame, is a
really useful tool for checking the exposure of
a digital image. The values depicted at the
left-hand end of the scale represent the
shadows (i.e., the darker tones). Tones at the
far left are completely black and show no
detail in the corresponding areas of the
image. The values in the center of the scale
represent the midtones and those on the right
the highlights (i.e., the bright tones). The far
right-hand end of the scale represents white –
in other words, highlights that contain no
discernible detail. The shape of the histogram
curve is unimportant, as it simply displays the
tonal values that are present in an image that
has already been captured. 

In order to get the most out of an image,
either during processing or later, when it is
published, it is preferable to have an image
that contains only tones that show some
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In this shot, lateral
sunlight from the left
produces wonderful
shadows. The low
viewpoint and the
wide-angle perspective
enhance the feeling of
great depth.

Full-frame DSLR | 15mm |
1/800s | f7.1 | ISO400



detail. The histogram of a ’correctly’ exposed
image shouldn’t contain any tonal values at
the extreme ends of the scale. Such extreme
values are an indication that the subject
contains too great a range of contrast to be
captured with adequate shadow and highlight
detail. One way to deal with such high-contrast
subjects is to shoot a bracketing sequence and
use the resulting source files to create a single
HDR (high dynamic range) image. 

Only image areas that contain discernible
detail can be processed effectively. Altering
the exposure parameters is one way to ensure
that an image contains sufficient detail.
Shifting the histogram curve to the right is

equivalent to increasing the overall exposure
value, while shifting it to the left makes the
image darker. However you decide to expose
an image, areas that contain no detail 
are virtually impossible to rescue during
processing. The only way to retrieve ‘lost’
detail is to copy pixels from an area that
contains appropriate data using dedicated
software such as Photoshop’s Clone Stamp or
Copy tools. This is complicated and doesn’t
always produce realistic-looking results. If, on
the other hand, there isn’t enough light
available to shoot handheld without
producing camera shake, all you have to do is
mount your camera on a tripod. 

The brightness, color, contrast and
saturation in a well-exposed image can all be
altered during processing to match the way
you remember the situation. However, all
these factors are easier to control if the image
contains detail throughout the tonal range
and there are no obviously under- or
overexposed areas.

Direction

Another extremely important factor
influencing the look of an image is the
direction (relative to the camera) from which
the light illuminating the subject emanates.
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The light from in front in the shot on the left
makes the rock look bright but rather 
two-dimensional. Only its shape and color
distinguish it from the background.
Full-frame DSLR | 15mm | 1/5000s |

f7.1 | ISO400

In the still life below left, the light entering
the window to the left produces a
three-dimensional look that emphasizes the
curves in the jug and bowl. An additional
reflector or accent light on the right would
weaken this effect. 
Compact camera (crop factor 1.3) | 35mm |

1/20s | f8 | ISO320

The depth created by the shadow pointing
toward the viewer in the backlit shot of a
tree below is further emphasized by the high
overall contrast. In situations like this, you
have to take care to prevent the highlights
from burning out.
Compact camera (crop factor 1.3) |
21mm | 1/125s | f8 | ISO160



Light comes basically either from the sides
(lateral light), from behind the photographer
or from behind the subject (backlight). Each
of these situations creates a very different
atmosphere. Lateral light that hits the subject
virtually at right angles to the camera’s optical
axis ‘grazes’ the subject, creating unique relief
effects and long shadows whereas the
shadows produced by frontal light (i.e., light
from behind the photographer) are not
usually visible because they are cast behind
the subject. The most effective shadows of all
are those produced by backlight. 

The vertical angle of incidence is important
too. Sunlight always comes from above,
although the time of year and the time of day
significantly affect the angle it comes from –
an aspect of composition that is particularly
important in architectural shots. 

Of course, we cannot influence the angle
of sunlight but we can wait for the sun to
move to the desired position. If this 
time-consuming approach isn’t suitable for
the shot you want to capture, the only other
alternative is to alter the position of 
the camera. This is a particularly effective
approach for people and other subjects that

can alter the direction in which they are
moving to suit the camera’s standpoint. 

In most other situations, altering the
camera position completely alters the
composition and often provides the benefit of
a new and more interesting view of a
well-known building or landscape. Changing
light nearly always throws up new
perspectives and detail in familiar subjects. If
the job you are doing requires a specific view,
you will simply have to wait for the right light.

The Color of Light

The time of day also influences the color of
light, as does the degree of cloud cover. It may
seem obvious, but consider the difference in
color between a cloudless blue sky and the
sky on a cloudy day. The nature of these
differences is described in terms of ‘color
temperature’, which is measured in units
called Kelvin (K). Low Kelvin values indicate
warmer-looking colors, while higher values
represent cooler colors. Daylight on a cloudy
day has a color temperature of about 5500 K,
whereas a cloudless sky has a Kelvin value
somewhere between 8000 and 12 000.  

The two basic approaches to color
rendition aim either to accentuate the colors
to underscore the mood of a shot (at sunset,
for instance) or to keep the colors as neutral
and authentic as possible (for instance, in an
advertising context in which the product is
the center of attention). Colors that are too
cool or too warm can easily reduce the
recognition value of a product just as a
‘neutralized’ sunset will probably not touch
the viewer’s emotions as much as one that
contains really ‘warm’ colors.

White Balance

The camera’s white balance setting enables
you to adjust the color temperature before
shooting, although most contemporary
cameras have very good automatic white
balance functionality that rarely fails to select
the right setting. If you want to select the
white balance setting yourself, you can
choose from a range of preset values tuned to
specific light sources such as sunlight, cloud,
tungsten light or flash. Most cameras also
allow you to set custom Kelvin values or
custom white balance by way of a reference
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The famous ‘blue hour’ shortly before dusk produces the most expressive images. If this shot had been captured any
earlier, the illuminations wouldn’t have been switched on and the image would have been dull and two-dimensional.
Any later, and the sky would have been much darker or even black.

Full-frame DSLR | 24mm tilt/shift lens | 1s | f8 | ISO200



photo of a white or gray card. The downside
of this approach is that white balance has to
be readjusted for each new situation. 

Manual adjustment is the most flexible but
also the trickiest approach to setting white
balance. Dedicated tools, such as gray cards
and filters, help you make a reference setting.
If authentic color reproduction is particularly
important to you, you are better off using a
reference color chart, which you will also have
to recalibrate for each new situation.

The Quality of Light

The fourth important aspect of light is its
‘quality’, a term used to is used to describe the
relative ‘hardness’ or ‘softness’ of a light
source. Midday sun in a cloudless sky
produces hard-edged shadows and is thus
considered ‘hard’, whereas the light from a
cloudy sky is soft and produces only vague,
indeterminate shadows. Just as light from
every angle is not necessarily suitable for
every subject, you also need to consider
whether the available light has the right
quality for the effect you wish to achieve.  

If you are shooting in a particular location,
it’s always a good idea to check out the
available light first and choose your subjects
accordingly. This is definitely the best
approach if you have only limited shooting
time at your disposal – evenings or at the
weekend, for example. On vacation, too, this
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The same scene captured three times using
different white balance settings, showing
how radically you can influence the look 
of an image while you are shooting. 
From top to bottom: Auto, 10800K, 3000K. 

Full-frame DSLR | 85mm | 1/1600s | f6.3 | ISO400



strategy can signficiantly increase the number
of successful images you bring home. In
contrast, pro photographers who have a
specific brief and are judged by the quality 
of their results simply have to wait until the
light is right.

The Interplay of the Four 
Major Aspects of Light
The amount, direction, color and quality of 
the available light all play a role in every
daylight photo, although the relative
importance of each will depend on the
individual circumstances and the subject. If you
shoot in a RAW format you can, if necessary,
alter the color temperature later during
processing, but the direction and quality of the
light are pretty well ‘set in stone’ the moment
you press the shutter release. These
considerations raise the question of whether
there are hard and fast rules that we can
observe to be sure of capturing the best
possible results in any situation. Although 
the interplay of all four factors determines the
overall quality of an image, certain aspects of
the composition process require special
attention, regardless of the subject. Note that
many of these considerations are equally valid
whether you are using flash, artificial light or
natural light to illuminate your subject.

The old adage “Where there’s light,
there’s shade” is a useful guideline when you

are composing photos. Shadows provide
contrast and can be placed virtually at will
depending on the direction of the incident
light and the camera position. The ‘harder’
the light, the crisper the shadows will be and
the more they will emphasize the
three-dimensionality of the image. Soft,

diffuse light produces only soft, diffuse
shadows. ‘Hard’ lateral light is often used to
emphasize the contours in male portrait
subjects’ faces, whereas the current dictates
of fashion seem to make soft, diffuse light
that produces little or no shadow preferable
when capturing portraits of women.
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The various ways of setting white balance
manually are all based on the same
principle, which involves photographing
a reference object under the same
lighting conditions as the scene you wish
to capture. 

The reference object can be a gray card
designed for use with digital cameras or a
translucent, purpose-built filter that is
fitted to (or simply held in front of) the
lens and is designed to diffuse the light
entering the lens to enable the camera to
record its color temperature. 

Whichever method you use to capture
your reference object, the camera then
compares the tones in the red, green and
blue channels with neutral values
recorded in its memory and calculates an

appropriate white balance value. If you
then photograph your reference object
with the new white balance value set, the
object should be rendered with perfectly
authentic colors. Take care not to
overexpose your reference shot and make
sure that there is visible detail in all three
color channels if you want it to function
correctly.

If you don’t have dedicated accessories like
those mentioned above, it is also possible
to set white balance manually using a
sheet of paper or a tissue. The important
thing to watch out for is that your
reference surface is a neutral white color. 

You can also use this technique to
produce complementary white balance
settings for colored reference objects.

Manual White Balance

A simple example of the effects of direct
and diffuse light. The warm tone of the
lateral sunlight in the right-hand image
emphasizes the wall behind the subject as
well as the texture in the subject itself.

Above: Full-frame DSLR | 85mm | 1/50s
| f5.6 | ISO250

Right: Full-frame DSLR | 85mm | 1/640s
| f4 | ISO250



It is always easier to assess the available
light in a familiar place but, if you are planning
to shoot somewhere you have never been
before, it is a good idea to use a dedicated
tool such as SunCalc (www.suncalc.net) to
check the movements and phases of the sun
at your chosen location before you get there.
Of course, the weather has to play along too,
but you can still make a good estimate of the
time at which you need to be in position to
make your shot. Using a dedicated tool to
plan a shoot saves a lot of time and helps to
you to concentrate on the shoot itself once
you are on location . 

Frontal light intensifies colors and
illuminates architecture evenly, while lateral
light emphasizes the three-dimensional
nature of a building and underscores 
the textures and features in its surface.
Backlight is a no-no when photographing
architecture unless you are simply taking
photographic notes or shooting
impressionistic or artistic shots in which the
shadows are as important as the building
itself. If this is the approach you wish to take,
the lower the sun, the longer and more
impressive the shadows will be. 

Generally speaking, photos taken when
the sun is high in the sky are less interesting
than those captured in the early morning or
towards the end of the day. The warmer
tones that often prevail in the late afternoon
benefit most compositions, even if the
overall quality of the light at these times is
softer than it is in the middle of the day. 

Especially for architectural shots, you will
simply have to decide whether soft, warm
light with a shallow angle of incidence is
preferable to ‘harder’ light from above. 
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The charm of this simple image lies in the way the brightest highlight is positioned
precisely on the small curve in the roof

DSLR (crop factor 1.6) | 22mm | 1/800s | f6.3 | ISO100

SunCalc is an online tool that enables you to visualize the phases of the
sun and the shadows it will cast for a given location at any given time

Even without refined lighting, this
passageway makes a great subject, but the
foreground shadow is the icing on the cake
and gives the image additional depth and a

feeling of space. In shots like this, it is
essential to line up the edges of the frame

with the vertical lines in the subject.

DSLR (crop factor 1.3)14mm |
1/125s | f16 | ISO200

Architecture





Capturing images of people in daylight
requires an a very different approach from the
one taken in the studio, where the
photographer can precisely control the color,
direction and intensity of the light. Daylight
people photos are more often than not the
preserve of hobby photographers and are
usually spontaneous, serving to preserve
memories or as visual notes. If you want to
take a more serious approach to daylight
portraiture, you will have to analyze the
surroundings and lighting conditions before
you begin to shoot. As far as the ambient light
is concerned, this means assessing the
direction it comes from and positioning
yourself and your subject accordingly. Do you
want to use frontal light, or is lateral or
backlight more appropriate? Does the
background look right for your preferred
lighting direction? These consideration may
sound complex, but are relatively simple to
master with a little practice. You will find that
you instinctively combine the various
elements of a location to form a coherent
composition. 

Just like with other subjects, portraits shot
in backlight display few shadows, and the
diffuse backlight produced by clouds is 
great for creating portraits with soft, 
flattering skin tones. Crows’ feet and other
slight skin blemishes are virtually invisible 
in soft sunlight. 

Lateral light increases definition, creates
more shadows and produces striking and
characterful results. Dark/light contrast can 
be used to make a broad face look thinner,
while wrinkles in a subject’s skin can be
deliberately accented using light from the
side. Especially in the late afternoon, backlight
can create a very effective halo or ‘rim light’
effect that accentuates the subject 
against the background.

If you do shoot portraits in backlight, you
will often need to use a reflector to brighten
your subject’s face so it doesn’t disappear into
the shadows. A simple sheet of Styrofoam
makes a great reflector and there is a wide
range of purpose-built collapsible gold or
silver photo reflectors available. If you are not
working with an assistant, you will also need
a tripod or stand fitted with an appropriate
clamp to hold your reflector in place while you
shoot. A shopping bag filled with stones is a
cheap and practical way to secure a light
stand against the effects of wind when you
are out and about. The very best option is, of
course, an experienced assistant who
constantly checks the angle and effect of the
reflected light. 
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When shooting with long exposure times, you have to
make sure that your subject is relaxed and that the head
is gently supported to avoid unwanted movements. 
Long exposure times often produce images that radiate
a special kind of calm.

Tripod-mounted full-frame DSLR | 85mm | 0.5s | f1.8 | ISO800  

Portraits and People Shots
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Daylight can be used to illuminate a
subject directly but can be reflected and
artificially manipulated too. Whichever
type of reflector you use, the larger its
surface, the more light it will reflect.
Additionally, the closer you position a
reflector to the subject, the more intense
its effect will be. Smooth surfaces reflect
light in a more direct, concentrated form
than matte or uneven surfaces.

A reflector should always be at least as
large as the object it illuminates. Paper is
too flexible and is therefore not particularly
effective, but cardboard works very well if
you feel it is not worth purchasing a
purpose-built reflector like the one shown
on the right. 

Styrofoam is stable and makes a very
effective reflector, and you can paint the
other side black to act as a shader or ‘flag’. 

Folding reflectors in various colors and sizes
are popular among outdoor photographers,
as are the larger aluminum-framed models
manufactured by California Sunbounce,
which are available with a range of
coverings that includes, gold, silver, white
and even zebra stripes. 

Gold and silver reflectors have a more
intense effect than white ones and can end
up dazzling the subject if not used with
care. Moderate amounts of reflected light
produce images with relaxed-looking
subjects and natural-looking levels of
contrast.

Fill Light in Portraits

This shot was captured about 30 minutes
before the one on the left in the shadow
cast by the building in the background.
This enabled the subject to look directly
into the camera with his eyes wide open. 

Full-frame DSLR | 135mm |
1/2000s | f4.5 | ISO800

In this shot, the sunlight created
extremely high contrast, so we decided
to expose to retain highlight detail at
the expense of some shadow detail. The
dark shadows emphasize the subject’s
facial features and make this a very
effective portrait.

Full-frame DSLR | 135mm |
1/8000s | f3.5 | ISO800



If you prefer to keep gear to a minimum,
you can always use appropriate parts of the
surroundings, such as brightly painted walls
or fences, as natural reflectors. You can then
adjust the brightness of the reflected light by
altering the distance between the reflector
and your subject. The color of a reflector is
important: white or light gray reflectors are
the most effective, although subtle yellow or
red tones can add an agreeable warm accent
to a portrait shot too. 

Try to keep accent lights as inconspicuous
as possible for the viewer. This works 
best if the reflected light matches that of the
surroundings and the image is composed so
that there is no visible transition between
the subject and the foreground. Long lenses

and wide apertures are a useful combination
for portrait shots.

There is a definite trend  toward using gold
reflectors to produce obvious highlights 
and accents in portraits with otherwise
neutral-looking backgrounds. This can
produce eye-catching effects but needs
to be used in moderation if you want your

images to look natural.
Diffuse daylight provides even-looking

light from just about every direction and gives
you a lot of freedom when it comes to
positioning your subject and selecting your

shooting angle. Such conditions are
particularly useful for group portraits. The
bright sunshine that so many people wish for
at family get-togethers doesn’t necessarily
provide useful photographic lighting. In
frontal sunlight (i.e., with the sun behind the
photographer), people will be well lit but will
often end up squinting into the sun or having
to wear sunglasses, which doesn’t make for
particularly relaxed or natural-looking photos. 

Even if the people you are photographing
aren’t keen on the idea, shooting in the shade
often produces much better results. If you
take this approach, it is always a good idea to
set white balance manually, especially if you
are shooting under trees, as they can easily
give a photo a green cast. Green-tinged skin
tones look strange and are difficult to correct
effectively. 

Another thing to look out for when
shooting in the shade is that the 
background is shaded too – otherwise, the
contrast within the frame will be too high and
the background will contain burned out
highlights. An alternative to shooting in the
shade is to use backlight. This might mean
that the photographer is the one who ends up
squinting, but that doesn’t affect the photos.
If you use a low sun as a backlight, you might
not have to brighten your subject’s face at all.
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A backlit portrait captured
in late afternoon sun in
fall. The gold-colored
reflector used to brighten
the subject’s face gives the
photo a sunny look with no
unwanted green-tinged
reflections from the
surroundings.

Full-frame DSLR | 135mm |
1/640s | f2 | ISO320

Right: this scene is located under a road
bridge that leads to a hill on the right, so
the subject is lit evenly and exclusively by

diffuse sunlight coming from the left 

Full-frame DSLR | 135mm | 1/250s | f2 | ISO400





Unless you are a landscape specialist, you
probably only shoot landscapes on vacation
or if you are out hiking or walking. However,
if you learn to incorporate the various aspects
of natural light into your photos, even
spontaneous opportunities can produce
impressive results, especially if the sun
happens to be shining.

As in most situations, the most impressive
landscape colors occur when you have the
sun behind you, although the resulting
images are often rather two-dimensional and
flat-looking. Backlit scenes provide the most
depth, although shooting with a telephoto

lens from a high viewpoint also produces a
more three-dimensional look, especially if
distant features of the landscape, such as
faraway mountains, appear in the
background. The further away an object is,
the lighter its colors become, so once again,
the soft, warm early morning and late
afternoon light provides the best landscape
photo opportunities. A low sun casts
interesting shadows that you can
incorporate into your composition, whereas
the short shadows produced when the sun is
high in the sky leave you little scope for
modulating the textures in an image. If you

are shooting in the early morning or late
afternoon, you need to work quickly, as the
light changes fast and gives you very little
time to check your settings and make test
shots.

Conclusions

If you take the trouble to look carefully 
at the light and the new opportunities it
provides on every shoot, you will quickly
develop an innate feel for how light behaves,
and you will be rewarded with consistently
exciting images. (pen)
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In this shot, the soft light from the cloudy sky produced muted colors and a virtually shadow-free image.
The composition is defined by the vertical tree trunks, the horizontal element provided by the boat and the
frame provided by the grass and the leaves and didn’t need extra shadows anyway.

DSLR (crop factor 1.6) | 50mm | 1/100s | f4 | ISO200

Landscapes

c
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Bernhard Stockmann

How to Create

Light Rays with GIMP
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The Sun’s rays shining through a church
window – a beautiful effect created
entirely in GIMP

Tˇhe effects produced by incident light can
be diffuse, highly directional or simply

random. Sometimes, when light is scattered
by clouds or formed into arrow-like rays by
windows, it produces effects with a unique,
mystical beauty all their own. 

These effects are the result of normally
invisible light rays being dispersed and made

visible by fog, dust or smoke particles in the
atmosphere. Recreating such effects digitally
is a relatively simple matter and can be
executed in the open source GIMP image
editing suite using the simple steps described
on the following pages. This type of edit can
be used to give all manner of images
additional atmosphere. (keh)
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Light rays diffused by the clouds or
shining ethereally through church
windows are just some of the effects
you can create using GIMP’s volumetric
lighting tools. This workshop shows 
you how to apply these fantastic effects
to your own images.
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Begin by selecting the places where the ‘light rays’ are to appear. To do
this, you need to make a black-and-white copy of the background layer in
which the ‘light’ areas are white and all other details black. To duplicate
the background layer, use either the ‘Create Duplicate Layer’ button at the
foot of the Layers panel or the Ctrl+Shift+D keystroke.

Step 1

The basis for this workshop is a photo of the interior of the
Guildhall in London. The steps described below show you how
to add digital ‘light rays’ that appear to shine through the
windows on the side of the building. 

GIMP Workshop – How to Flood a Room with Volumetric Light

After

Before
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Step 2 Now select the Colors > Components > Channel
Mixer command and check the Monochrome option.
The preview image will now be displayed as a
grayscale image. 

To emphasize the bright areas, shift one of the three
color channel sliders all the way to the right and
leave the other two set to zero. This produces a
version of the grayscale image in which the tonal
values are determined by the values captured in a
single channel. 

The brighter parts of most images are recorded in
either the blue or the red channel, while highlights
are rarely found in the green channel. In our example,
we shifted the blue slider all the way to the right and
kept the other two at low settings. The result is a
high-contrast image in which the dark gray tones
tend toward black, thus further emphasizing the
bright windows.

Step 3 Now use the Colors > Levels dialog to adjust the last
remaining gray tones. The Input Levels histogram
reveals that the image still contains quite a few dark
gray tones. Move the left-hand (black point)
triangular slider to the right to shift the dark gray
tones to black. Similarly, moving the right-hand
(white point) slider to the left brightens the
remaining light gray tones so that they become 
pure white.
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Now use the Brush tool with a wide
tip to ‘paint out’ any remaining
highlights that you don’t wish to
include in your ‘light ray’ effect.

Step 4

Duplicate the edited monochrome
layer and hide the duplicate (in our
example, the ‘Lights copy’ layer) by
clicking the eye icon to the left of the
layer thumbnail. Now select the
visible monochrome layer and apply
the Filters > Blur > Gaussian Blur filter
with a Radius value of 30.

Step 5

Step 6 Optionally, you can also color the
‘sunlight’ you have created on the
blurred layer to give it a warmer
yellow/orange tone. To do this, select
Color > Colorize and shift the Hue
slider to a value between 30 and 40.
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Step 7 Switch the layer mode of the edited layer to
Screen. This blends the bright areas in the
edited layer with those on the layer beneath 
to create a ‘glow’ effect.

This is where we produce the all-important 
‘light rays’. Reactivate the topmost copy layer 
by clicking the eye icon on the left. 

Now navigate to Filters > Blur > Motion Blur 
and select appropriate values. We used a
Linear/Length value of 256 and an Angle of 
168 degrees. Applying this effect can take 
some time, depending on how powerful your
computer is and the values you select.

Step 8

You can further emphasize the rays using
the Filters > Enhance > Unsharp Mask filter.
This tool makes the image sharper by
increasing the amount of contrast between
the individual object edges. An Amount
value of about 2.30 and a Radius of 5 make
good starting points for your experiments.

You can increase the length of the ‘rays’ by
re-applying the Motion Blur filter to the
edited layer using the same settings as
before. Doing this to our sample layer
produced the result shown on the right.

Step 9
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Altering perspective in the ‘rays’
layer adds vitality to the scene.
Activate the Perspective tool by
pressing Shift+P and zoom out a
little (using the scroll wheel with
the Ctrl key pressed) to give
yourself a clearer view. In our
example, we ‘stretched’ our
image toward its top right corner.
Press Enter to confirm your
changes.

Step 10

To ensure that only the white 
rays remain, delete all the
remaining black pixels using the
Colors > Color to Alpha dialog.

Step 11

Use the eraser to delete any stray
rays that appear in the wrong
places.

Step 12
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Adapting the color of the rays to fit the scene 
makes them look more realistic. To do this,
duplicate the ‘rays’ layer and switch the layer
mode of the layer beneath to Value. This uses
the color values from the lower layer to color
the one above.

Step 13

Another way to add emphasis to the light rays
is to darken the entire base image (i.e., the
background layer) by dragging the image curve
slightly lower in the Colors > Curves dialog.
Adjust the opacity of all three layers to balance
their individual effects and give the image its
final polish.

Step 14

c
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Dmitri Popov

The Return of 

LightZone
LightZone used to be a commercial program but is now
available as part of an ongoing open source project.
We checked out its strengths and weaknesses and how
it compares with established favorites like Lightroom
when used as part of the daily digital photo workflow. 



Today’s photographers are spoiled for
choice when it comes to RAW processing

software. From Adobe Lightroom and Apple’s
Aperture digiKam, there are processing and
editing applications available for every need
at a wide range of price points. So what does
LightZone have to offer to entice enthusiasts
and professional photographers away from
their current favorite tools? The price and
platform support are two obvious points that
make it an appealing proposition. The
application is distributed free of charge and
it’s available for several popular platforms. A
low price alone is no guarantee of success, but
LightZone has a few tricks up its sleeve that
make it a viable alternative to the commercial
competition.

LightZone’s interface follows some well
established conventions, so finding your way
around the main Browse and Edit modules
shouldn’t cause any major problems. The
Browse module lets you pick a directory and
perform basic operations on the photos it
contains. All photos in the current directory
are displayed as thumbnails in the thumbnail
bar at the bottom of the window, and all you
have to do to view a large preview image is
select a thumbnail. You can then edit the basic
info such as rating, title, location, etc. in the
Info sidebar. In other words, the Browse

module is a pretty standard affair. Things get
more interesting when you switch to the Edit
module. The first thing you will notice is the
Styles sidebar on the left with its long list of
options. A LightZone Style is essentially a
preset that allows you to apply multiple
actions in a single step. Styles are arranged

into logical groups. The Black & White group,
for example, contains various monochrome
conversion presets, while the Detail
Enhancement group offers styles for
sharpening images and improving local
contrast. In addition to existing styles,
LightZone allows you to save the operations
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The Browse module is used 
to preview RAW files and

photos and edit basic info
such as ratings, titles and

locations. Use the ‘Send’ and
‘Convert’ buttons in the main
toolbar to copy the currently

selected photo to another
directory or convert it to a

different format.

The name LightZone may sound familiar
to some photographers. This unique RAW
processing application enjoyed a fair
amount of popularity until the LightCrafts
company who manufactured it abruptly
went out of business, leaving LightZone
users high and dry. However, the
LightZone community didn’t give up on
the product and the LightZombie
website quickly became a hub for those
still interested in using the program. The
website features updates and patches
that helped to keep the original
LightZone functional and, toward the end
of 2012, the program’s core developers
announced that the application had been

resurrected as an open source project.
Now, following a few months of intensive
development, the first new version has
been released for Linux, Mac OS X and
Windows.

Although the new release has a different
version number, it doesn’t differ much
from the last commercial version of the
application. The main focus of this release
was cleaning up and updating the existing
code base. Nevertheless, a new, free, open
source LightZone is great news for
photographers looking for an alternative
to existing commercial RAW processing
and photo editing software.

Background



you have applied to the current photo as a
custom Style, making it easy to build up your
own library of presets. Existing Styles can be
tweaked too, and the Preview panel located
above the Styles list displays mouseover
previews.

The editing tools are located in the Tools
sidebar. Instead of cramming all of its features
and controls into the editing interface,
LightZone’s programmers have taken a more
refined approach that distills the essence of
the available editing functionality into a
handful of key tools with only a few adjustable
parameters. While some photographers may
find this approach limiting, most users will
probably find the tools on offer adequate for
most editing tasks. More importantly, the
simplified tools make it much easier to master
the basics of the editing process.

In addition to the standard Sharpen,
White Balance and Hue/Saturation tools,
LightZone offers a couple of unique and
genuinely useful tools in the form of Relight
and ZoneMapper. The former is an effective
tool for improving overall lighting in an
image, which it does by reducing broad-scale
contrast and increasing local contrast. While
the resulting effect depends on the nature of
the photo you are editing, in many cases
simply applying the tool using its default
values produces extremely impressive
results. Like most of the tools on offer,
Relight has only a handful of parameters for
you to play with.

ZoneMapper

ZoneMapper is LightZone‘s trump card. It
enables you to adjust the brightness and
contrast of an entire image or selected image
areas for any combination of the highlights,
midtones and shadows. As the name implies,
this tool is based on the Zone System
developed by Ansel Adams and Fred Archer in
the 1940s. The original Zone System assigns
numbers from 0 through 10 to different
brightness values (known as zones), with 
0 representing black, 5 middle gray and 
10 pure white. Each zone in this system differs
by 1EV. The LightZone ZoneMapper adapts the
system to fit the realm of digital photography,
comprising 16 zones that differ by 1/2EV. The
tool works in conjunction with the ZoneFinder,
which is accessed via the Zones section of the
preview pane located above the Tools sidebar.
Once you have enabled the ZoneMapper tool,
hover the mouse over a specific zone to
highlight it in the preview thumbnail. This
simple technique lets you quickly identify the
different zones in a photo, and you can then
adjust your desired zones by expanding or
compressing them using the mouse. Although
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LightZone features a comprehensive
collection of Styles with mouseover
preview functionality. You can add
your own custom Styles or tweak the
ones supplied as standard.

LightZone offers a handful of key
tools with a relatively narrow range

of adjustable parameters. This makes
the application easy to master, but
some photographers may find the

approach somewhat limiting.



you can quickly get to grips with the
ZoneMapper tool simply by experimenting
with different settings, knowledge of the
traditional Zone System will help you to get the
most out of this unique feature.

Raw Adjustments

Other useful tools include Raw Adjustments,
which you can use to tweak various 
exposure, temperature, color noise and other 
image attributes. Additionally, LightZone
automatically removes hot pixels, and the
Clone tool is really handy for removing
unwanted objects from your photos. The Spot
tool is perfect for removing dust, scratches
and other blemishes.

Like most serious RAW processing and
photo editing applications, LightZone features
non-destructive editing, so none of the steps
you take are applied directly to the original
image data. The application keeps track of all
the changes you apply, and you can view and
undo them in the History section of the
left-hand sidebar. When you close an editing
session, the program saves all modifications
in a separate lzn.jpg LZN file which contains
the JPEG version of the original photo 
along with the applied toolstack. In the 
Browser module, the original photo and its
corresponding LZN file (or files) are displayed
as a stack. You can use the ‘Expand image
stacks’ button to view the original and its
associated LZN versions. The clever part of this
feature is that it allows you either to edit the
original photo from scratch (thus creating a
new version with a separate LZN file) or
continue editing the latest LZN file. This
approach allows you to simply maintain and
manage multiple versions of a single image.
Better still, LightZone allows you to pick a
toolstack from an LZN file and apply it to other
photos. Like most of the tools in LightZone,
this functionality is straightforward to use – all
you have to do is select the desired LZN file,
click the ‘Copy toolstack’ button, select the
target photo and click ‘Paste toolstack’.

Conclusions

While the features we have described make
LightZone a powerful RAW processing and
photo editing application, it does have some
weaknesses too. Although it remembers the
most recent location, the Browser module has
no bookmarking functionality, making it
difficult to switch between directories that you
use regularly. You can edit a file’s basic
metadata, but there is no way to view its full
Exif data. The program allows you to sort
thumbnails using different criteria (capture
time, rating, aperture, ISO, etc.), but it doesn’t

provide any filtering capabilities and there is no
search feature either. LightZone also lacks lens
correction and perspective adjustment tools
and doesn’t yet feature Curves and Levels tools.
Last but not least, file export is limited to TIFF
and JPEG formats, and there is no support for
uploading photos to popular sharing services.
In spite of its simple and powerful toolset, some
photographers may find LightZone too
simplistic and possibly even limiting.

Even though LightZone isn’t designed to
replace powerful all-around applications like
Lightroom and digiKam, it still makes a
genuinely useful addition to any digital
photographer’s toolbox. The application is
particularly useful for applying a few quick
adjustments to a handful of RAW images. The
Relight and ZoneMapper tools produce
impressive results with a minimum of effort and
the fact that the software is available free of
charge for a variety of platforms leaves you with
no excuse for not taking it for a spin! (sea)
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The Relight tool can dramatically
improve a photo by adjusting its
contrast settings, and is great for
applying a quick fix to underexposed
images or improving overall contrast

Based on the Zone System devised by Ansel Adams and Fred Archer, the ZoneMapper
tool allows you to adjust the brightness and contrast of an entire photo or selected
image areas. Like LightZone’s other tools, this powerful feature is really easy to use. c
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RAW Processing
in Lightroom and Photoshop

Over the last seven years, Lightroom has evolved from a simple but
effective RAW converter into a powerful all-in-one digital photo
workflow tool. The latest version includes a wide range of improved
processing tools and makes it easier than ever to perform your entire
workflow, from import to print-ready output, within the Lightroom
interface. In spite of all this progress, Lightroom hasn‘t caught up with
Photoshop, which offers a set of standard tools that is unparalleled in
its power and range. This article compares the two programs and shows
you where Photoshop still has the upper hand. 
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Photoshop has long been considered an
indispensable tool for most digital

photographers. However, its status is
changing, and with every new processing 
tool that Adobe builds into Lightroom, the
idea of launching Photoshop becomes less
compelling. In spite of its world-beating
toolset, Photoshop is not particularly agile, and
it is often faster and simpler to perform all
your basic processing steps within Lightroom.
From a purely creative point of view, there is
still no alternative to Photoshop. However,
most people’s everyday digital photo
workflow is less about the creation of artistic
masterpieces than it is about eliminating the
technical shortcomings of a wide range of
photos, and that is exactly where Lightroom
still needs to improve. This article looks in
detail at some standard editing scenarios and
points out where you are probably still better
of using Photoshop. 

New vs. Old 

Designed from the ground up for RAW
processing, Lightroom first hit the streets in
2007. Because there is no standard RAW file

format available, it is not advisable to write
directly to RAW files. Lightroom has read-only
access to original RAW files and saves all the
changes made to an image in a separate
metadata file that is then linked to the original
image. The main advantage of this approach
is that is entirely non-destructive, and the only
way to actually damage an original image is
to physically delete it from your hard disk. This
also means that, because alterations are
stored in the form of metadata-based
instructions, they can be edited or completely
reversed at any time during processing, and
you can revert to any previous image state
(including the unprocessed original) at the
click of a button. In contrast, the Photoshop
History function allows you to step backward
while you work but deletes its records of the
steps you take as soon as you save a file.

Having grown organically over more than
20 years, Photoshop has  reached a degree of
complexity that matches its age. It lacks any
kind of unified tool interface and you simply
have to learn how to use each function
separately as and when you need it., Lightroom,
on the other hand, has a relatively simple user
interface and is much more user freindly. 

Photoshop also has a fragmented approach
to processing and was originally designed
with exclusively destructive processing
functionality. Today’s version includes
non-destructive editing capabilities in the
form of Adjustment Layers and Smart Objects.
However, it is still too easy to change or
overwrite an original image file
unintentionally, although RAW files are
potected by the separate Adobe Camera Raw
module, which has read-only access to the
original files and hands over new versions to
Photohsop for processing. 

Photomontage 
only in Photoshop
Unlike Lightroom, Photoshop creates a new file
when processing RAW images, which makes
managing your image archives more
complicated. On the other hand, Lightroom
doesn’t offer functionality for combining
multiple images in a single new image. In
other words, you have to use Photoshop if you
want to perform any kind of photomontage,
which of course limits the range of
Lightroom’s retouching functionality. 
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Moving an Object in Photoshop
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Before

After

1⎢Select the Content-Aware Move tool and use it to select the
object you wish to move and drag it to the desired location.
This step doesn’t require its own layer. 

2⎢Copy the object you wish to insert from its source image,
create a new layer in the target image and paste the copied
object there.  

The task: 

Move the kite surfer to the left and enhance the
background with elements copied from a different
image. 

Processing steps:

The solution:

Both steps are relatively simple and require the use of
Photoshop layers.

3⎢If you select Extend mode  and check the Sample All Layers
option, the selected object will be automatically adjusted
and inserted at the pointer location. If the source and target
images don’t have similar color, texture and brightness,
further tweaking will be required. The Stamp tools are the
best option for correcting the transitions between the old
and new images areas.



Moving an Object in Lightroom

The Lightroom interface is simple to learn
and most users will quickly be able to produce
attractive results. However, when it comes to
performing complex processing steps, you
will quickly discover the limits of its built-in
functionality. The program offers just one tool
for each specific task and, if the available
functionality doesn’t serve your desired
purpose, you will have to switch to Photoshop.
The Spot Removal tool is a good example for
which Photoshop offers multiple options,
including the Healing Brush, Patch,
Content-Aware Move, Clone Stamp and
Pattern Stamp tools. The downside of
Photoshop’s powerful toolset is the
complexity of each tool’s handling, and only
experienced users can really use its
comprehensive functionality to the full. Even
for the relatively simple examples shown here,
we often have to summarize sets of steps to
keep things clear.

No Layers in Lightroom

The lack of Layers is one of Lightroom’s major
drawbacks. You can add layer functionality
using the PerfectLayers plug-in from onOne
Software but, as with all after-market tools, it
is not smoothly integrated in the program’s

interface and forces you to move the files you
want to process back and forth between the
plug-in and Lightroom. 

The simple fact that Photoshop layers can
be individually and comprehensively adjusted
and manipulated means that Photoshop is a
much the better option when it comes to
making sophisticated adjustments. Layers can
be grouped and individually named, making
it simple to keep track of even the most
complex processing steps. You can also
change the order of layers at will and
fine-tune your adjustments at any time.
Adjustments made with Lightroom are
restricted to the single layer offered by each
image file and, because the program creates
History panel entries for every step, it can
quickly become unclear which steps
produced which results. You can go back 
to each individual step, but we don’t
recommend that you make targeted
adjustments in previous steps because
Lightroom then switches all the following
steps back to the earlier version too. 

The following pages introduce the
retouching tools that are part of the latest
version of Lightroom and list their particular
strengths and weaknesses. Photoshop users
will find all of Lightroom’s native tools built

into the Adobe Camera Raw RAW processing
module. 

Crop Overlay

The Crop Overlay tool can be used to perform
crops and straighten images. The Constrain to
Warp option, which is unique to Lightroom,
enables you to automatically exclude any pixel-
free image areas produced by transformations
from the final output file. This is particularly
useful in view of the fact that Lightroom doesn’t
offer functionality for filling empty pixels and
using it to perform transformations and warps
inevitably causes a loss of image data. 

Photoshop is much smarter in this respect
and is even capable of creating brand new
pixels that it generates automatically from
neighboring image areas using the Content-
Aware Fill tool. While it retains the original
image size, this approach can create
unwanted artifacts in complex textures and
patterns. At the end of the day, you will
usually have to perform some manual 
fine-tuning for pixels generated by
Photoshop, whereas in Lightroom you simply
have to decide whether to keep any
remaining pixel-free areas or remove them
by cropping the image.
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Lightroom doesn’t have a
dedicated Move tool, but
you can use the Spot
Removal tool in Clone mode
to perform a similar
function. To copy an object,
you have to mask the target
area rather than the source
area and then cover up the
‘empty’ source area when
you are done. Because it is
so imprecise, this approach
is not really suitable for use
in critical situations.
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Distortion Correction in Photoshop

Before

After

2⎢Photoshop automatically
generates new pixels
based on the 
surrounding details. Any
unwanted artifacts that
result can be eliminated
using the Clone Stamp
and Patch tools.

1⎢Correcting distortion and/or perspective creates
pixel-free areas at the edges of the frame. If you don’t
want to crop these out, you have to select them 
(preferably using the
Magic Wand tool) and
fill them with new 
pixels.

Navigate to the Edit >
Fill dialog and select
the Content-Aware
option.

The task: 

Our source image shows strong distortion that we
wish to correct while retaining all the original
image data. We also want to avoid cropping the
corrected image, as important details are located
at the edges of the frame. 

Processing steps:

The solution:

Tools for correcting distortion and perspective are
available in Adobe Camera Raw and in Photoshop
itself. 

The rectangular shape of the original image is
distorted by the correction process, but the
pixel-free areas that result can be filled using the
Content-Aware Fill tool.
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Distortion Correction in Lightroom

Red Eye Correction
The Red Eye Correction tool in the current
version of Lightroom is the same as the
previous version and will be familiar to
Photoshop users too. Once you have selected
the area you want to apply it to, you can
manually adjust the size of the pupil and the
tone of the new fill color. This useful function
is simple to apply, and the Lightroom version
is just as good as its Photoshop counterpart. In
the unlikely case that the tool fails, you can
also use Lightroom’s Adjustment Brush to
manually correct any unwanted red areas in
portrait subjects’ eyes, so there is no need to
switch to Photoshop.

Using the Graduated Filter,
Radial Filter and 
Adjustment Brush
Lightroom’s Graduated Filter, Radial Filter 
and Adjustment Brush buttons are located
together because they all use masks to limit
the effect of the adjustments they apply.
Alongside standard parameters such as

Exposure and Tint, the drop-down list of tool
options includes more exotic options such as
Teeth Whitening and Iris Enhance. All of the
listed effects are available for all three filters,
although not all of the resulting permutations
make sense (using the teeth whitening effect
with a graduated filter, for example). The
effects all use the same palette of sliders,
which can be used to adjust settings and save
sets of parameters as presets. 

The Graduated Filter tool fills a
two-dimensional space that covers either the
entire breadth or the entire height of the
image and is perfect for adjusting the look of
the sky in a landscape photo, but he degree
of user control is fairly coarse. For example, if
you need to recolor a sky while leaving the
mountain range beneath it untouched, you
will have to switch to Photoshop and use a
custom mask. The only fully user-defined
elements of a graduated filter are its start and
end points. 

In comparison, the Photoshop Gradient
tool is highly customizable and can be applied
on its own layer or configured via the Alpha
channel. This enables you to use it to create

organic-looking asymmetrical gradients and
select individual objects. You can then convert
the contents of the Alpha channel into a
selection and use the result to perform color
adjustments on a selected object or create a
new adjustment layer. 

The Lightroom Radial Filter tool creates
circular or elliptical masks that can be made
virtually undetectable using the Feather slider
and is ideal for adding highlights to an image
or accentuating a portrait subject against the
background.  

This filter too, is fairly simple and offers
only a limited range of adjustments. There is
no Photoshop equivalent, although the effect
can be duplicated using layer masks – a
process that is more complex than applying
the Lightroom (or Adobe Camera Raw) filter
but gives you much more control. You can,
for example combine shapes to form a single
filter. In Lightroom, you would have to apply
multiple filters to produce the same effect,
which has the added disadvantage of
cumulating the effects of the filters 
you applyand seldom produces genuinely 
useful results. 
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Lightroom includes the same distortion and
perspective correction tools as Photoshop’s
Adobe Camera Raw module. However, unlike
Photoshop, it has no functionality for filling, 
or even selecting, the empty pixels that result
from applying them. The only way to eliminate
the pixel-free areas is to crop them, which
inevitably produces a smaller frame and
destroys image data.



Custom Gradients and Masks in Photoshop
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1⎢Open the New Channel
dialog in the Channels
panel and create a new
channel. Use the Lasso
tool to select the object
you wish to protect (in
our case, the kite).

Before

After

The task: 

The original image is a
little dull. We want to use
a custom gradient to liven
up the sky while leaing
the kite unchanged.

Processing steps:

The solution:

Unlike Lightroom,
Photoshop enables 
you to create custom
gradients in which
individually selected
elements are excluded
from the effect being
applied. If we use the
Alpha channel to create
a gradient, we can adjust
its effect at any time.



111c’t Digital Photography 16 (2014)

RAW Processing | Lightroom vs. Photoshop 

2⎢Activate the new channel
by clicking the eye icon in
the Channels panel, then
use the Edit > Fill 
command to fill the 
selection with white.

The Lightroom
Graduated Filter

Unlike Photoshop, Lightroom can only
produce linear gradients, although these
can be rotated. The only way to produce
an asymmetrical gradient in Lightroom is to
use the Adjustment Brush to accentuate
the effect of an existing gradient in
selected image areas. A Lightroom gradient
cannot be selectively adjusted or
counteracted. The grayscale versions of
sample gradients reproduced below show
the significant differences between the
two. 

4⎢Now create a selection
from the object and fill it
with black in the gradient
channel. You can now use
an adjustment layer to 
fine-tune the white areas
of the combined 
gradient/object channel.
The object itself will be
protected by the 
black-filled selection and
won’t be altered by your
changes. This way, the kite
remains unchanged even
though the sky around it
has been edited.

3⎢Create an additional Alpha
channel and use the 
Gradient tool to insert a
gradient into it. Use the
Ctrl+A shortcut to select
the entire channel and use
the Edit > Transform >
Warp command to shape
it as required.
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Replacing Objects in Photoshop

1⎢Select the source object using
the Lasso tool. Use the Select >
modify command to feather the
edge of the selection using a
value of around 0.5 pixels. This
setting ensures that the inser-
ted object doesn’t display ob-
vious edges or transitions when
inserted into the target image.
Now copy your selection to the
clipboard.

vorher

nachher

The task: 

Group portraits are often
spoiled by a single subject
looking in the wrong direction
or moving during the
exposure. Especially in large
groups, it is virtually impossible
to catch a moment at which
everyone is looking at the
camera and smiling. The
solution is to create a new
photo by combining elements
from multiple source images.

Processing steps:

The solution: 

Photoshop‘s Layers
functionality makes it simple
to combine elements from
multiple source images in a
new image file. However,
even in sequences shot in
burst mode, you will rarely
find two images that can be
merged without additional
fine-tuning of the details.
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2⎢Switch to the target image and
insert the selection.

3⎢Select the objects that are directly in front of the inserted object and then select
and duplicate the background layer. Add a layer mask to the duplicate layer to
mask the selected objects and use the Refine Mask dialog to fine-tune its effect –
a feathered edge is usually a good idea. The layers need to be arranged so that 
the one with the foreground objects 
is on top, followed by the inserted 
object and the background.

4⎢If the inserted object still doesn’t quite match the original image,
use the Stamp tool (or similar) to fine-tune the details manually.

Replacing Objects
in Lightroom

Combining files and/or objects to
create panoramas, HDR images or
group portraits is not possible in
Lightroom. Photoshop is the obvious
choice for these kinds of operations.

Precise Editing with 
the Adjustment Brush

The Adjustment Brush, Lightroom’s most
precise editing tool, makes it easy to edit
irregular shapes by applying various effects
using a brush. It has a much more subtle effect
than its Photoshop counterpart and is ideal for
retouching portraits. The basic shape of the
subject remains largely unchanged, even if
you apply color shifts, so while it is a great tool
for enhancing an existing look, it is not
suitable for making significant changes to the
individual elements of an image. 

If you check the Auto Mask option near the
the bottom of the tool’s panel, the program
automatically determines where an object’s
edges are – a function that mostly works very
well and saves you having to outline every
detail by hand. In places where the tool
doesn’t correctly identify an object’s edges,
the color smears that result are easy to
remove using the Erase function. Pressing the
Alt/Option key switches the tool from brush
to eraser mode, enabling you to ‘paint out’
any excess areas of the mask. Once again,
Photoshop’s selection and Layer-based tools
are much more powerful and enable you to
perform more subtle and complex edits and
precisely mask the parts of the image you
wish to exclude from the effect you are
applying.

The default settings open the Adjustment
Brush showing just a single slider. To add and
adjust additional parameters, you have to click
the small black triangle in the top right-hand
corner of the Effect or Brush sub-panels to
expand the list of available options, which
includes Exposure, Contrast, Highlights,
Shadows, Clarity, Sharpness and Saturation.
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Content-Aware Scaling in Photoshop

The task: 

We need to change the shape of an image from rectangular
to square. The only way to achieve this in Lightroom is to
crop it. However, because cropping the image would
delete important elements of the composition, this is not
the solution we are looking for. 

Before After

Content-Aware Scaling in Lightroom

Content-aware scaling
is not possible in
Lightroom. The only
way to create a square
image is by cropping
the original, which
inevitably causes a
loss of image data.

The solution:

The answer to this particular dilemma is to use Photoshop’s
Content-Aware Scale tool to enlarge the area covered by the sky.
This approach retains all of the important details in the lower
portion of the frame and enhances the overall effect of the image.
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3⎢You can now scale the new 
content to match the original
image. Remember that this
‘stretches’ the pixels in the X or
Y direction and that overdoing
things can produce unwanted
artifacts.

1⎢Use the Image > Canvas Size command
to alter the size of the image as 
necessary, using the arrow keys in the
dialog to select the direction in which
you want to extend the canvas and the
Rectangular Marquee tool to select the
area you wish to scale.

2⎢Now select the Content-Aware
Scale command from the Edit
menu. This fills the 
additional canvas space with 
pixels based on the surrounding
content. The effect works best
for simple colors and textures.

Spot Removal in 
Photoshop and Lightroom

The Spot Removal tool has been one of
Lightroom’s staples right from the start, but
the new version can do a lot more than just
edit or stamp circular image areas. It is now
capable of editing freehand shapes, and every
shape you draw is automatically assigned a
source area. It can also be switched between
Clone and Heal modes. Clone mode inserts
the source pixels into the target area on a
one-to-one basis, whereas Heal mode adjusts
the copied content to match its new
surroundings. 

The quality of the results depends entirely
on how suitable the source pixels are. The
larger the area you wish to edit, the less likely
it is that the tool will complete the job
satisfactorily. The Photoshop Spot Healing
Brush is similar in name only, and is actually a
completely different tool that functions
without using source pixels. However, the
Photoshop Patch, Clone Stamp and Healing
Brush tools all  use user-defined source aresa
to apply their effects.

Of these, the Patch tool is the most similar
to Lightroom’s Spot Removal tool, although
we were able to achieve better results using
the Spot Healing Brush. The Photoshop tool
appears to be based on a different algorithm.
Nevertheless, compared with earlier versions
or similar tools available in other RAW editors
such as Nikon’s Capture NX 2, the new
Lightroom Spot Removal tool is a powerful
feature that raises converter-based image
editing to a new level and only pales when
compared directly to the equivalent
functionality in the almighty Photoshop. 

We Still Need Photoshop!

There is simply no getting around the fact that
Photoshop layers are an essential part of any
complex editing process because they allow
you to perform tricks like applying Clone
Stamp effects to a separate layer. Custom
layer masks are another feature of the
Photoshop  workflow that Lightroom simply
cannot compete with.

On the positive side, Lightroom’s standard
toolset is now sophisticated enough to

perform a wide range of basic editing tasks
without having to switch to another program.
It is highly user friendly too, and much faster
to use when it comes to performing basic
editing tasks. On the other hand, as our
examples on the preceding pages show,
Lightroom is still unable to perform some
relatively simple processing tasks, and only
future versions will show whether Adobe
intends to further enhance its non-destructive
RAW processing capabilities.  

The Future of Lightroom

The tools Lightroom offers become more
capable with every release, but theyare still
not comprehensive or flexible enough to
allow you to go it alone without the help of a
dedicated editing program. Layer support and
better masking capabilities are high on
everyone’s Lightroom wish list, as is the ability
to merge images or parts of images.
Photomontage is an indispensable part of the
digital photo workflow and Lightroom isn’t yet
the true all-in-one package it is probably
destined to become.  (sts)  c

Processing steps:
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There are many ways to train your
photographic vision, your ability to ‘see’.

The simplest is to observe traditional rules of
composition and then move on to expand
and deepen your perception, an approach
doesn’t involve planning ahead but rather
‘emptying’ your mind and remaining
impartial, open to what may happen. A
person who has trained to work this way can
view the world as if for the very first time. If
you can immerse yourself in the magic of the
moment and engross yourself in the present,
you will be able to rearrange and portray it
intuitively with your camera. This approach
works best when we stop judging the
material world and instead attempt to
become part of it. Suddenly things that we
might otherwise perceive as negative – like
the fence full of holes shown here – seem to
resonate with a beauty that speaks to our
artistic side. There is more than one way to
photograph the New York skyline and, seen
through a crescent-shaped hole in a blue
construction site fence, it looks quite
unfamiliar. To find subjects like this, you
need to take your time and look beyond the
usual tourist traps. This photo was taken in
the New York suburb of Williamsburg using
a 28mm lens set to f11. 
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Great photographers do more than just reproduce what the eye sees.
They have the ability to express emotions and sensations visually so
that the viewer can empathize with the way the photographer was
feeeling during the shoot. To achieve this, you need great timing, 
a good command of composition and the right attitude. This
workshop explains how to develop these skills for yourself.
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Consciously observing the world through a photographer’s eye is like carrying a set of picture frames around in our
thoughts that we use to frame the world. Small frames represent telephoto focal lengths, medium-sized frames normal
focal lengths and large frames a wide-angle viewpoint. Any location that seems to resonate for you is a good place 
to position such a ‘frame’ and release the shutter.
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To be fully aware while taking
photographs, we have to refine our
own ability to see and extract from the
surroundings only those things that are
central to an image and the concept it
embodies.

Photographers who have trained their
imagination can envisage the effect of a
change in focal length on the subject without
having to actually look through the lens. They
are capable of assessing their surroundings to
find compositions in which form and color are
consistent and produce a harmonious whole.
Nothing superfluous should be visible; only
the elements that are central to the photo and
the idea it embodies should be seen. It’s like a

multiple-choice test in which you have to
choose the correct part of the content on offer
and eliminate the rest.

This can be particularly difficult in a
constantly changing ‘street photography’
environment where you constantly have to
make split-second decisions.

For example, the view of Frankfurt
opposite shows it as a photographer would
see it initially – as a whole. Three potential
subjects are outlined in red and the one
showing a passing cyclist, who only makes a
really interesting subject when combined
with the colors and shapes in the foreground
and background. The catch here is that you
have to be able to spot opportunities like this
in an instant.

Of course, we all concentrate on what
interests us most. If our theoretical

photographer looking at the city of
Frankfurt is interested in modern
architecture, she may well choose Norman
Foster’s Commerzbank Tower (upper right),
but those who are more interested in details
of shape will perhaps prefer to isolate the
railing post on the left.

Producing authentic photos means
instinctively selecting the subjects that work
for you. Criticism and analysis have their place
later on, but when you’re actually pressing the
shutter button, it’s best to rely on your
intuition.

Photography as a ‘Multiple Choice’ Exercise

The Commerzbank Tower looks
even more striking in black and

white, as the postcard-perfect
sky looks almost black rather

than blue. This photograph was
taken using a 70-200mm lens

set to 84 mm.

This part of the scene is interesting only
because of the cyclist. It is perfectly valid to

compose a photo by combining an
immobile detail with a moving object.

The railing post and hoses present an
opportunity to photograph the scene from
a different perspective. If details like this
interest you, it is always a good idea to
capture your subject from various angles
and choose your best shot later on.
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Human perception is extremely
subjective for a very good
reason: if we were to be fully
conscious of all the sensory input
from our environment, we would
be hopelessly overwhelmed.

Seeing is a complex process. Just like the
aperture in a camera, the pupils in our eyes
open wider if it’s dark and become narrower
in bright light. Our eyes then send the images
they see in upside-down format to our brain,
which processes them so that they present 

a familar view. The poet Johann von Goethe
was right when he said, “We see only what 
we know.”

The brain also has to filter the thousands
of impressions it receives every second so
that we can orientate ourselves, especially in
highly stimulating places like big cities. It
decides which of the external stimuli should
be allowed to enter our consciousness and
which should be kept out so that we are not
overwhelmed. In a photographic context,
this filter is highly subjective and is shaped
by our personal history, our interests and
passions, and also by what we find
distasteful.

When I teach photography, I like to help
students understand this reality by having
them walk through central Berlin for half an
hour without talking. Their task is simply to
take everything in. When they come back, 
I ask them to immediately write down 10
impressions that come to mind.

It almost always turns out that everyone is
oblivious to about 80 per cent of the things
the others noted, even though everyone
followed the same route. Impressions
obviously vary in intensity, and our memory is
the best indicator – the things we remember
best are those that make the strongest
impression on us.

How We Perceive our Surroundings

When walking the streets of a big city, it pays to look
at inconspicuous things like this strut, which is part 
of the New York High Line elevated railway system.
Dada artist Kurt Schwitters used his famous
‘decollage’ technique to declare such apparently
banal objects as works of art, and photography is 
a perfect way to achieve a similar degree of
abstraction.
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Whatever makes it through our
‘filter’ into our consciousness
makes an impression, either
weak or strong. Only the
strongest impressions are worth
turning into a photograph.

Success in sharing our impressions with
others photographically depends on how we
compose our images. Essentially, this boils
down to alllowing our emotions to shape our
compositions. If you want to produce emotive

images that really ‘speak’ to the viewer, you
have to photograph intuitively without
thinking too much about the rules of
composition (which we will nevertheless
tackle on the following pages). 

However, it is still essential to train your
vision. The best – in fact the only – way to do
this is to analyze your results and check
whether an image is too ‘busy’ or whether it
has a recognizable center. The more often we
analyze our own photos, the better we will
instinctively apply our findings to future
images. Switching between analysis and
real-world shooting sessions is guaranteed to
improve your compositional ability over time.

We need, too, to reflect on the impressions
that produce the strongest feelings. If they
have something in common, perhaps that is
an indication that we have happened upon a
theme that we should pay closer attention to.
Of course, ‘nice’ impressions of attractive
cities, landscapes or lighting moods will have
quite a different effect on us than supposedly
‘ugly’ scenes. But it is often the unattractive
places that are most fascinating and that can
be transformed into unconventional and
powerful images. Better still, because they
make you look and think differently, these
places are far less likely to tempt or trick you
into producing shallow, superficial photos.

Composing with What We Feel

Top-notch technical skills are required here. Under
normal conditions, most sensors would burn out the
highlights on the right, so the solution is to use a
graduated filter to darken the right-hand part of the sky
by two or three stops.

This old industrial building in New York is not
particularly  attractive at first sight but, like

many such subjects, has a beauty all its own
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Taking photographs involves
arranging visual elements within
a defined area. Visual language is
anything but logical, but
nevertheless incorporates several
hard and fast rules. Whether or
not you observe these
determines whether your
photographs will be potent or
pathetic, harmonious or horrible.

The Golden Section, the effects of triangles on
a composition and other visual rules are not
artificial standards that have been dreamed
up recently. They reflect the basic tenets of
human perception and describe what most
people find visually pleasing when they look
at an image. The idea of theGolden Section
dates back to Ancient Greece and refers to the
division of an image into sections defined by
a ratio of 1:1.618 (i.e., approximately 3:5). The
horizontal and vertical lines that make up the
Golden Section are often referred to as

harmonious dividing lines. Together with the
axes of symmetry and the diagonals, these
lines comprise the basic visual framework in
an image. If you align key elements of your
composition with this framework, they will
look and feel like they have been arranged
‘properly’. It is easier for the human eye and
brain to take in images laid out like this, which
is why advertising images are often composed
this way.

Other important visual elements include
circles, slanted lines and dots or points.

Traditional Compositional Rules

Never mind that one steeple of the cathedral in
Bremen is obscured by scaffolding. Using a
telephoto lens to zoom in and reduce complexity
produced an image with a clear a clear-cut visual
language. The contrast between the rectangle and
the triangle gives the image above its vibrancy and
the smaller rectangle at the top of the scaffolding
connects the two shapes. I used a polarizing filter
to darken the blue of the sky.
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Images that are more obviously oriented to
the vertical and horizontal lines or the axes of
symmetry generally appear more static and
stable, sometimes even rigid, whereas images
oriented to the diagonals or other sloping
lines are more dynamic and less stable, but
certainly never dull.

Rules of composition are subject to the
viewer’s cultural expectations too. For
example, it’s useful to know that native
speakers of right-to-left languages like
Mandarin and Hebrew read images in the

same direction that they read text, while
Western viewers read images from left to right.

Keeping It Simple 

Research has shown that, for Westerners,
the first point of entry into an image is a little
to the left of the vertical and a little above the
horizontal axis of symmetry. If you know this,
you can deliberately place important
elements in this position and automatically
direct the viewer’s gaze in the direction it

would take when reading. If you intend to
look at life through a camera, you need to
learn how to arrange visual elements. 

Most amateur photos simply have too
many elements in them so it is a good idea to
practice composing simplified images that
contain just a few selected objects like the
triangle and rectangle in the steeple and
scaffolding shown opposite.

Like many aspects of the visual arts, great
photography often lives by the tried and
trusted post-modern motto “less is more”.

The Golden Section at work. The key lines in this photo 
of a storage tank in Bremen are oriented around the
harmonious dividing lines. Typical of an image that 
adheres closely to the Golden Section, this image is 
calm and pleasing but also rather startic.

The photo below is much more dynamic, and not just
because it was taken in New York. The steps to the High

Line overhead railway form an almost perfect rising
diagonal, a visual element that is often perceived as

positive and further emphasizes the fact that Western
cultures ‘read’ images from left to right. The blur of the car

in the foreground reinforces the feeling of momentum.
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Because you don’t have to think about
whether the colors clash, it is
sometimes easier to compose images in
black and white than in color. However,
you have to take care that the beauty
and intensity of the medium don’t blind
you to other important factors.

Black-and-white photography has its own
rules: it is more sparing with sensory stimuli
and therefore more ascetic than color
photography, but it forces you to use light and
shade more frequently. When you are starting
off, sunny days are the most suitable for getting
the hang of black-and-white photography –
you’ll soon discover that it is a highly graphical

medium. For instance, it is easy to create visual
rhythm using carefully selected lines. The
rhythm can be woven into the image in an
obvious way or more subtly and can be chaotic,
organic, or quite strict, as in the main photo
opposite, in which the passer-by contrasts
most pleasingly with the strong, constant
rhythm of the tapering lines of the building.

This dramatic image of a ruin
has a surreal effect due to the
way the Gothic arch on the
right is simply ‘cut off’. A
polarizing filter and the
Photoshop yellow filter were
used to darken the ocean and
the sky. 

Image composition in black and white
involves a great deal of experimentation

with light and shade. In this image, the
shadow of the tree and the clouds form an

obvious but highly organic rhythm.

Both images on this page were shot in
Menton, France.

Classic Black and White Composition
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A word of warning: don’t let compsitional
theory tempt you to use the Golden Section
or triangular patterns and strong rhythms in
every shot. All these rules do is describe what
we subconsciously recognize as harmonious,
and that is already part of the way we
experience things. Always try to work
intuitively, go with your gut feeling and wait

until later to evaluate your images
intellectually according to formal criteria. This
approach works particularly well if you
discuss your work with friends or other keen
photographers. Insights we gain by analyzing
things with others automatically become part
of our intuitive way of seeing things and
improve our photographic ‘eye’. 

Perfect timing is a must in black and white
photography and was absolutely crucial 

in both of these photos.

I waited a long time outside the Schirn Art
Gallery in Frankfurt for the right person to

happen along and give this image its
all-important finishing touch. The vibrancy of

this image comes from the strong rhythm of the
graphic lines and the off-center composition.

This boy is about to run exuberantly 
down the steps in front of the Castel
Sant’Angelo in Rome. Setting up a shot
and then waiting for the key moment is
an important lesson to learn.
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One way to approach
photography is to give careful
thought to what you want to
portray before going anywhere
near the shutter button. What
you end up capturing depends
very much on how you see the
world – or how you would like 
to see it.

Ansel Adams was a master at portraying the
poignancy of an intact world, and this is an
approach that is still legitimate today. You
can interact with the natural environment
and capture especially beautiful moods, or
maybe travel somewhere distant that’s really
different for you. A trip like the one to Nepal
that yielded the photos on this page can be
very hard work. You need to be enthusiastic
and motivated, and the price to be paid for
incredible views like these is a lot of legwork

and lack of sleep, especially if you are visiting
a developing country. The Dhaulagiri massif,
Machapuchare (Fishtail Mountain) and the
Annapurna section of the Himalayas are so
stunning in the early morning light that 
it is almost impossible to come away with a
poor photo. 

For many Westerners with a conscience
about the environmental damage caused by
humans, photos like this create a conflict.
Should we really engender such a utopian

How Do You Want to Portray the world?

With a beautiful scene before me, like this sunrise along the
Annapurna range in Nepal, I find it almost impossible to shoot a
bad photo, though sadly it is equally difficult to squeeze the
grandeur of the mountains into a tiny photo. A telephoto lens
creates a slightly flat tableau-like impression while a wide-angle
combines the mist in the valley with the receding rows of peaks
to create a feeling of depth.
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take on the world? On the other hand, there
are very few contemporary photographers
who concentrate on unspoilt natural
beauty.

Since the mid-20th century, a new
approach to landscape photography
developed as photographers begin to reveal
the less attractive side of modern landscapes.
In industrial countries it has become almost
impossible to photograph intact landscapes
without being suspected of falsifying the

world or at least glossing things over. For the
same reason, ‘Realist’ painters had already
begun to distinguish themselves from the
‘Naturalist’ movement by portraying society’s
paradoxes instead of just an idealized view of
the world.

Contemporary photographer Hans
Christian Schink, from Leipzig, Germany,
shows the ruthless intrusion of the modern
world on the landscape in his images of
highway and railway bridges in eastern

Germany. His unequivocal large-format
photos show clearly how concrete destroys
the innate harmony of natural landscapes.

I am among those who believe that it
would be an artistic lie to allow my photos to
suggest that all is well in the natural world in
the early decades of the 21st century.

Nepal, too, has problems galore – poverty
and a lack of infrastructure to name the most
pressing – which are rendered invisible if we
portray only the beauty of the Himalayas.

Unlike the images of the Himalayas, this idyllic, typically
Italian landscape near San Remo with its chapel, pine trees
and cypresses, takes great liberties with the truth. In the
next section, we will see how profoundly and convincingly
photos can ‘lie’ to us.



128 c’t Digital Photography 16 (2014)

Workshop | Learning to See

It is often claimed that photography
is an objective medium because it
depicts something that really existed
at a certain place at a certain time.

Not depicting an object is an act that can be
just as significant as depicting it, and both
approaches can interfere with objectivity.
Consider, for example, what is going on
behind the photographer’s back at the
moment the shutter is released. My ‘Janus’
seqeunce explores precisely this question.
Janus was a Roman god who could look in

two directions at once. The images in this
series speak for themselves and clearly show
what a fragile thing supposed objectivity is. 

This makes it all the more astonishing that
the renowned Becher School of photography
postulates that photography is an objective
medium, when it is so easy to prove
otherwise. Hilla Becher and her late husband
Bernd were of the view that photographers
should be as unobtrusive as possible and
allow their subjects to speak for themselves.
In their own photos, they always show their
subjects in medium gray light from a static
full-frontal viewpoint.

Their extensive body of work deserves
recognition, but these apparently neutral
images of old industrial buildings are just as
lacking in objectivity as those of Reinhart
Wolf, who created intense atmosphere 
by photographing industrial buildings in
glittering sunlight in a way that almost made
it possible to make out faces in the façades.

Photography is definitely not objective but
is certainly authentic. The difference between
objectivity and authenticity is critical and
something that photographers quite literally
have to keep an eye on when searching 
for subjects. 

Can Photography be Objective?

This view of a beach and the sea in Noli, Liguira, suggests beautiful surroundings,
even in overcast weather. The right-hand image gives no hint of the less attractive
view behind the boat.
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Photography makes a statement,
not just about the material
world, but also about our
thoughts and feelings. It is 
an expression of our subjective
experience. 

Photographer and lecturer at the Folkwang
University of the Arts, Otto Steinert, coined
the idea of ‘subjective photography’ back in
the 1960s and 70s. To his way of thinking,
photographs are not logical and rational but

rather ambiguous and emotional, so it makes
good sense to portray one’s own subjective
moods in photographic images.

Therefore, learning to see involves finding
and discerning counterparts in the tangible
world for everything we sense internally, so
that we can effectively communicate what we
feel in a visual way.

To find out more about yourself, pick a
time when you are feeling relaxed and
simply allow your feelings to guide you.
Which places really capture your
imagination or intrigue you? These might be
the entire countries, cities, certain types of

landscape, or smaller details within your
surroundings, like the Jewish cemetery
around the corner, a courtyard between
buildings in the Turkish part of town, a
refuse dump at the edge of a city or majestic
old trees in a park or forest. It is always better
to avoid the well-known locations listed in
guidebooks, as these usually produce
disappointing results.

Get to know your special places using
your camera. Take your time about it and try
to explore alone so that you are not under
pressure to move on or intellectualize 
your feelings.

Subjective Photographic Impressions

Photography is the ideal medium for
conveying mood. The image on the left has
a bright, magical mood that conveys
spaciousness and beauty. It was taken in
winter on the Island of La Palma
This is another image in which I had to take
care to prevent the highlights in the ocean
from burning out.

The image on the right – of a pedestrian
walkway under a highway – expresses

confinement and constriction. Both
images  on this page were captured

using a central viewpoint, but the
vanishing-point perspective in this one

really draws the viewer in.
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In the first part of this workshop, we
concentrated on consciously setting up
the world around us to capture it
photographically. Now let’s turn our
attention to letting go of conceptual
thinking and starting to see things
‘directly’.

We have already considered how to use our
intellectual perception of the modern world

as a basis for creating photographs of our
surroundings. In contrast, we can also learn to
see our surroundings ‘directly’ without the
filter of knowledge or preconceptions.

Our normal way of perceiving the world
involves incorporating everything that we
know and our own experiences into a frame
of reference – a framework that is often
referred to as a person’s ‘world view’.

It works more or less like this: we see
something and try to fit it immediately and
directly into our world view. To do this, part of

our being has to exit the experience of seeing
and begin to make comparisons. We compare
what we have seen – be it a landscape, a plant,
a person, a city or a castle – with similar,
previous visual experiences and attempt to
align it with our knowledge of that type of
object. Processing all this input, our mind
evaluates what we have seen and fits it into
our own personal frame of reference.

While fitting our perceptions into safely
labeled ‘boxes’ may help us feel more
secure, it distracts us from simply seeing

What is Direct Perception?

Heading off into the city without a predetermined concept while
simultaneously opening your mind to new experiences is a journey of
discovery – there is always so much new to see. Silhouettes are one of
the first stages of composing images in a more abstract way. This
image works because of the contrast between the the silhouttes and
the red-lit wall. The image was captured at ISO 1600 and 1/64 s using an
82mm focal length with the stabilizer activated the lens to prevent
unwanted camera shake.

Another powerful silhoutte image
captured in an Indian restaurant in

New York. The structure is clear and
simple, and the paper lampshade and
the Indian script on the window blend

nicely into the overall composition.
The image was captured at 1/100 s

using a 135mm lens.
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what is there. We end up thinking we know
the world already, instead of experiencing
and discovering it with the impartiality 
of a child.

Let Go of Labels

There is nothing wrong with approaching the
world rationally. On the contrary, there are
many situations in which it is extremely
useful – getting to know a new city or
photographing a specfic topic are two good

examples. But ‘seeing directly’ is quite
different and is all about taking things in
without any filters so that our intellect is kept
at bay while we simply go ahead with an
experience.

And why should you take this approach?
Because the rational part of our intellect,
which judges, evaluates and allocates things
to a place in our world view, is the part of 
our mind that separates us from the true
depth of the experience and the immediacy
of perceiving it. Rational understanding

packages everything we experience in
language. The problem with that is that the
word for an object is not the same as the
object itself. It restricts us, confuses us, diverts
us and leads us down the wrong path. 

The surrealist painter René Magritte
explored this phenomenon by painting
things like apples and pears and labeling
them with the wrong names. He was aiming
to confuse viewers and make a pear, for
example, seem more alive, rather than have
viewers follow the same old tracks in their

Framed vistas, simply by the way they are set up, add an additional
layer to a photo and almost always establish a feeling of depth.
Here, a beautiful heritage window leads the eye into a courtyard full
of bright primary-colored umbrellas, while the figure in the
background provides a nice finishing touch. 
An intuitive approach was key in this shot, although a good
understanding of the relationship between aperture and depth of
field enabled me to instinctively select f13 to provide sufficient
detail throughout the frame.

Photographs shot in the rain often have a
certain poetic melancholy. In this shot, it
was important to focus on the raindrops

and bathe the fruit stand in the
background in blur. To achieve this effect I
used a relatively wide aperture of f5 and a

19mm wide-angle lens. The viewer’s eye is
drawn diagonally from bottom left to the

red umbrella in the top right-hand corner,
which providees the composition with an

important anchor. At ISO 800, it was still
just possible to shoot handheld at 1/25 s.
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mind and just think of the word ‘pear’. He
wanted viewers to experience the pear in all
its real-world sensuality rather than simply
reduce it to a label. 

And that is exactly what ‘contemplative
photography’ is all about: expanding our
ability to perceive things by not automatically
labelling everything we see, allocating it to a
defined position in our world view and
evaluating it, but instead switching off our
rational side and simply observing and taking
things in via our senses. If you manage to
clear your mind and throw off your

prejudices, it is as if you are seeing the world
for the first time. This is a deep-set feeling
that enables us to  compose photos easily
and intuitvely.

Putting Theory into Practice

Seeing the world with such enhanced
perception and blending what we perceive
with the view through the camera can be a
real joy. It is like diving into a very special river,
which is perhaps why people talk about the
‘flow’. It’s a river in which everything simply

unfolds and happens all by itself, and it is
always a river of enthusiasm. Without
enthusiasm, it is unlikely that a photo will turn
out well.

Having got into the flow, you find that
photographs just seem to happen and almost
compose themselves. You will begin to swap
lenses automatically as if the images you are
shooting have taken hold of you and are
guiding you, rather than the other way
around. You lose track of time, you don’t even
notice that you’re hungry and you simply
plow on until you find that you are no longer

Using reflections is a brilliant way to merge two or more perceptual layers in a single image. Here, on the roof
terrace of a New York bar, life inside merges with the outside world to form a most unusual composition. Shot
using a focal length of 100 mm, I had to stop down to f13 to produce sufficient depth of field. 
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in the flow and that the traffic signal has
turned red, the city stinks of vehicle fumes and
that you’re surrounded by ceaseless noise.
None of these things penetrated your
consciousness while you were one with your
immediate experience, because your
evaluative consciousness was temporarily
switched off.

I deliberately encourage people to take
photographs in this way because we
Westerners have been schooled too well in
approaching life rationally. Yes, it’s important
to use your equipment well and practice

analyzing images, but don’t photography
books suggest that technology is responsible
for at least 80 per cent of the quality of a
photo? I simply don’t agree!

Discover New Worlds

It is much more important to be able to
devote yourself to the experience of seeing,
and too much thinking about equipment can
prevent you from doing just that, especially if
you are still experimenting with your gear and
your photographic style. But learning to see

also means learning to look intensively, which
works best if you forget everything else and
rely completely on your intuition to guide you
and help you capture an image.

Once you start seeing this way, you’ll find
whole new worlds opening up. You may
discover silhouettes, interesting vistas or
intriguing reflections that allow themselves to
be condensed into intriguing, abstract image
compositions. The more you practice, the
easier it will become to intuitively consolidate
several layers of perception into balanced
works of art. 

Another multi-level composition, photographed
in Baden-Baden, shows the reflections of two

women window shopping.

This image was photographed through the window of a car with a mannequin inside it. So many layers are
combined here that it is not immediately apparent how they relate to each other. But don’t feel you have to rush
off to New York to hunt down such opportunities: this photo was shot in Ludwigshafen, Germany.
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The term ‘meditation’ is often
dismissed because of its association
with esoteric practices, although all
it really is is a way of calming your
spirit and opening your mind to
new experiences.

At times when we are alone and take notice
of what is going on within us, we discover
our ‘internal storyteller’ – a voice that is

seldom completely silent. Even in good and
happy times, our subconscious can pop 
up with thoughts of an unfinished tax return
or a noisy neighbor, and spoil the intense
experience of a beautiful moment.
Meditation is all about freeing oneself from
these unprofitable thoughts and fully
savoring and appreciating the moment. As
we saw in the previous section, photography
can do a brilliant job of leading and guiding
us into the moment and encouraging us to
concentrate on seeing while leave unhelpful

thoughts behind. This is what I mean by
‘meditative photography’.

Meditation is all about immersion, and
you can practice meditative photography
anywhere, concentrating on seeing to
achieve a feeling of peace and freedom from
prejudice. Once you have got into a
meditative flow, you will also be able to
rediscover the commonplace and use your
camera to create art from things you would
neither see nor value in an everyday state
of mind. (keh)

Abstract and Meditative Views

This traffic sign behind a fabric barrier looks
even more commonplace seen from behind
but, if we disregard its intended function, we
begin to discern an attractive interplay of
shape and color. This image was shot with a
190mm telephoto lens set to f6.3 to keep the
background out of focus.

This prayer flag blowing in the wind throws a distinct shadow and 
is balanced by the red detail on the right. It was a very bright day, 
so I was able to stop right down to f16 to retain sufficient depth of field.
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Photographer, author and photography
tutor Torsten Andreas Hoffmann was born
in Duesseldorf and studied photography at
the Braunschweig University of Art. His
work has taken him to India, Indonesia,
Mexico, Nepal, Turkey, the USA, the Sahara
and the UAE. His photographs have been
displayed at many leading galleries and
have appeared in more than 20 books as
well as in many national and international
magazines.

Hoffmann is also known internationally
for his New York photo books and art
calendars, and especially for his pictorial
analysis of the events surrounding 9/11.

Hoffmann works in both the traditional
black and white and conceptual color

photography genres, often using paired
images to deliver his message (see the
example from the Janus sequence on
page 128). He has also published a
pictorial comparison of Frankfurt and 
New York in book form. His latest work 
is a sequence called Natur-Architektur.

Participants in Hoffmann’s workshops are
encouraged to forge their own individual
path, drawing from his numerous
instructive articles and his book The Art of
Black and White Photography (published
by Rocky Nook). His latest book,
Photography as Meditation (due for
publication this summer, also by Rocky
Nook), he investigates how to train your
intuition to become an integral part of
your creative drive.

About the Author

Who wants to go out on
a rainy day in November?
However, days like this
are opportunities to
discover some fabulous
subjects simply by
changing your point of
view. Look down to see
the reflections of neon
lights and turn them into
a photo. Because I was
shooting at f13 to retain
depth, I had to use a
tripod to keep the
camera steady during
the long 2.5-second
exposure. c
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Lürzer’s Archive is an advertising trade
journal with a global reputation, and

appearing in its pages is considered a serious
accolade for advertising photographers all 
over the world. For each bi-annual volume, 
a presitgious jury combs the archives 
and chooses the 200 best advertising
photographers worldwide. These lavishly
illustrated books contain virtually no text, but
the large-format photos mostly speak for
themselves anyway.  

Each volume showcases photos shot in the
course of the creation of real ad campaigns but
doesn’t use the actual advertising posters that
result. This means that – apart from the obvious
car photos – you will have to read the captions
to find out which product each image relates to.
When top-flight photographers are given a brief
in the monied world of advertising, the results
are always enthralling and often electrifying
too. In addition to the
advertising shots, the
book includes a
sprinkling of the
photographers’ own
publicity images. These
are not always up to the
same technical standard
as the contract work
done for clients like
Samsung, Schweppes
and Guinness, and

sometimes look more like snapshots alongside
the other sophisticated campaign shots and
Photoshop creations. Nevertheless, the images
on display here include everything from 
high-end beauty shots to some real shockers –
in the advertising world anything that attracts
attention is permissible.

The range of subjects covered is broad
although, as can be expected, the colorful world
of product placement leaves sensitive themes
such as politics and religion completely out of
the picture. Otherwise, the work on show covers
just about all branches of the photographic
oeuvre, including sports, landscapes, industrial
scenes, people, food and still life. 

This book provides great reference images
for all these sub-genres and more. Above all, as
an entertaining and inspiring collection of
high-end eye candy, it is a treat for lovers of
advertising and high-class photography. (sts)

Advertising Photo Gems
Lürzer’s 200 Best Advertising Photographers

Soft pastel shades and a dignified
atmosphere set the perfect stage
for the girl and her outrageously
colorful donuts. This shot for the

Claire’s jewelry brand is a real 
eye-catcher. Im
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200 Best Ad Photographers
Worldwide 2014/2015
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Wildlife Photography 
with Benny Rebel 

❚ˇBenny Rebel is one of the brightest stars on
today’s wildlife photography scene. His work
has taken him to Kenya, South Africa, Uganda,
Costa Rica and India, where he has produced
many of his well-known photos of animals shot
from extreme perspectives. In our exclusive
workshop, Benny explains some of his favorite
tips and tricks for producing extraordinary
wildlife photos.

Telephoto Zoom Test

❚ˇTelephoto zooms are the tool of choice for
photographers who want to get close to their
subjects but keep their composition options
open. Wildlife and travel photographers
especially appreciate the versatility of this type
of lens. We test the best of today’s offerings in
the lab and on location, and give you the 
low-down on what they do best and what
could still be improved.

Color Corrections
in Lab Mode

❚ˇPerforming color edits in RGB mode often
takes time and patience. In contrast, the clear
separation of brightness and color values in the
Lab color space makes it a lot easier to achieve
the effects you are looking for. Our in-depth
article explains the basics of Lab-mode
processing and introduces the appropriate
tools in three different Lab-capable programs.

Coming up in Issue 17
• • • • •
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